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Caution

NO LIABILITY IS ASSUMED FOR ANY DAMAGE CAUSED BY IMPROPER INSTALLATION.

Notice on Software

SOFTWARE USED WITH THIS PRINTER MUST SUPPORT THE PRINTER’'S EMULATION MODE. The printer is factory-set to
emulate the PCL. The emulation mode can be changed by following the procedures described in Chapter 1.

Notice

The information in this manual is subject to change without notification. Additional pages may be inserted in future editions. The user
is asked to excuse any technical inaccuracies or typographical errors in the present edition.

Noresponsibility is assumed if accidents occur while the user is following the instructions in this manual. No responsibility is assumed
for defects in the printer’s firmware (contents of its read-only memory).

This manual, any copyrightable subject matter sold or provided with or in connection with the sale of the page printer, are protected by
copyright. All rights are reserved. Copying or other reproduction of all or part of this manual, any copyrightable subject matter without
the prior written consent of Kyocera Corporation is prohibited. Any copies made of all or part of this manual, any copyrightable subject
must contain the same copyright notice as the material from which the copying is done.

Regarding Tradenames

PRESCRIBE is a registered trademark of Kyocera Corporation. KPDL and KIR (Kyocera Image Refinement) are trademarks of Kyo-
cera Corporation.

Diablo 630is a product of Xerox Corporation. IBM Proprinter X24E is a product of International Business Machines Corporation. Epson
LQ-850 is a product of Seiko Epson Corporation.

Hewlett-Packard, PCL, and PJL are registered trademarks of Hewlett-Packard Company. Centronics is a trade name of Centronics
Data Computer Corp. PostScript is a registered trademark of Adobe Systems Incorporated. Macintosh is a registered trademark of
Apple computer, Inc. Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation. PowerPC is a trade-
mark of International Business Machines Corporation. ENERGY STAR is a U.S. registered mark. All other brand and product names
are registered trademarks or trademarks of their respective companies.

This Kyocera Mita page printer uses PeerlessPrintXL to provide the HP Laserdet compatible PCL6 language emulation. Peer-
lessPrintXL is a trademark of The Peerless Group, Redondo Beach, CA 90278, U.S.A.

This product was developed using the Tornado™ Real Time Operating System and Tools from Wind River Systems.

AGFA @ This product contains UFST™ and MicroType® from Agfa Corporation.

— usB

©2001 by KYOCERA CORPORATION. All rights reserved, Revision 1.0., October 2001




IBM PROGRAM LICENSE AGREEMENT

THE DEVICE YOU HAVE PURCHASED CONTAINS ONE OR MORE SOFTWARE PROGRAMS (“PROGRAMS”) WHICH BELONG
TO INTERNATIONAL BUSINESS MACHINES CORPORATION (“IBM”). THIS DOCUMENT DEFINES THE TERMS AND CON-
DITIONS UNDER WHICH THE SOFTWARE ISBEING LICENSED TOYOU BYIBM.IF YOU DONOT AGREE WITH THE TERMS
AND CONDITIONS OF THIS LICENSE, THEN WITHIN 14 DAYS AFTER YOUR ACQUISITION OF THE DEVICE YOU MAY
RETURN THE DEVICE FORA FULL REFUND. IF YOU DO NOT SO RETURN THE DEVICE WITHIN THE 14 DAYS, THEN YOU
WILL BE ASSUMED TO HAVE AGREED TO THESE TERMS AND CONDITIONS.

The Programs are licensed not sold. IBM, or the applicable IBM country organization, grants you a license for the Programs only in the
country where you acquired the Programs. You obtain no rights other than those granted you under this license.

The term “Programs” means the original and all whole or partial copies of it, including modified copies or portions merged into other
programs. IBM retains title to the Programs. IBM owns, or has licensed from the owner, copyrights in the Programs.
1. License

Under this license, you may use the Programs only with the device on which they are installed and transfer possession of the Programs
and the device to another party.

If you transfer the Programs, you must transfer a copy of this license and any other documentation to the other party. Your license is
then terminated. The other party agrees to these terms and conditions by its first use of the Program.

You may not:

1) use, copy, modify, merge, or transfer copies of the Program except as provided in this license;
2) reverse assemble or reverse compile the Program; or
3) sublicense, rent, lease, or assign the Program.

2. Limited Warranty
The Programs are provided “AS IS”.

THERE ARE NO OTHER WARRANTIES COVERING THE PROGRAMS (OR CONDITIONS), EXPRESS OR IMPLIED, INCLUD-
ING,BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE.

Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.

SUPPLEMENT TO AGREEMENT FOR SOFTWARE BUNDLING AND DISTRIBUTION FOR ALDC

3. Limitation of Remedies
IBM’s entire liability under this license is the following;

1) For any claim (including fundamental breach), in any form, related in any way to this license, IBM’s liability will be for actual
damages only and will be limited to the greater of:

a) the equivalent of U.S.$25,000 in your local currency; or
b) IBM’s then generally available license fee for the Program

This limitation will not apply to claims for bodily injury or damages to real or tangible personal property for which IBM is legally liable.

IBM will not be liable for any lost profits, lost savings, or any incidental damages or other economic consequential damages, even if
IBM, or its authorized supplier, has been advised of the possibility of such damages. IBM will not be liable for any damages claimed by
you based on any third party claim. This limitation of remedies also applies to any developer of Programs supplied to IBM. IBM’s and
the developer’s limitations of remedies are not cumulative. Such developer is an intended beneficiary of this Section. Some jurisdictions
do not allow these limitations or exclusions, so they may not apply to you.

4. General

You may terminate your license at any time. IBM may terminate your license if you fail to comply with the terms and conditions of this
license. In either event, you must destroy all your copies of the Program. You are responsible for payment of any taxes, including
personal property taxes, resulting from this license. Neither party may bring an action, regardless of form, more than two years after
the cause of action arose. If you acquired the Program in the United States, this license is governed by the laws of the State of New York.
If you acquired the Program in Canada, this license is governed by the laws of the Province of Ontario. Otherwise, this license is
governed by the laws of the country in which you acquired the Program.




Typeface Trademark Acknowledgement

All resident fonts in this printer are licensed from Agfa Corporation.

Helvetica, Palatino and Times are registered trademarks of Linotype-Hell AG.

ITC Avant Garde Gothic, ITC Bookman, ITC ZapfChancery and ITC Zapf Dingbats are registered trademarks of International Type-
face Corporation.

Agfa Japan License Agreement Guidelines

1.

10.

11.

12.

“Software” shall mean the digitally encoded, machine readable, scalable outline data as encoded in a special format as well as the
UFST Software.

You agree to accept a non-exclusive license to use the Software to reproduce and display weights, styles and versions of letters,
numerals, characters and symbols (“Typefaces”) solely for your own customary business. Agfa Japan retains all rights, title and
interest to the Software and Typefaces and no rights are granted to you other than a License to use the Software on the terms
expressly set forth in this Agreement.

To protect proprietary rights of Agfa Japan, you agree to maintain the Software and other proprietary information concerning the
Typefaces in strict confidence and to establish reasonable procedures regulating access to and use of the Software and Typefaces.
You agree not to duplicate or copy the Software or Typefaces, except that you may make one backup copy.

This License shall continue until the last use of the Software and Typefaces, unless sooner terminated. This License may be
terminated by Agfa Japan if you fail to comply with the terms of this License and such failure is not remedied within thirty (30)
days after notice from Agfa Japan. When this License expires or is terminated, you shall either return to Agfa Japan or destroy all
copies of the Software and Typefaces and documentation as requested.

You agree that you will not modify, alter, disassemble, decrypt, reverse engineer or decompile the Software.

Agfa Japan warrants that for ninety (90) days after delivery, the Software will perform in accordance with Agfa Japan-published
specifications, Agfa Japan does not warrant that the Software is free from all bugs, errors and omissions.

THE PARTIES AGREE THAT ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF FIT-
NESS FOR A PARTICULAR PURPOSE AND MERCHANTABILITY, ARE EXCLUDED.

Your exclusive remedy and the sole liability of Agfa Japan in connection with the Software and Typefaces is repair or replacement
of defective parts, upon their return to Agfa Japan.

IN NO EVENT WILL AGFA JAPAN BE LIABLE FOR LOST PROFITS, LOST DATA, OR ANY OTHER INCIDENTAL OR CON-

SEQUENTIAL DAMAGES, ORANY DAMAGES CAUSED BY ABUSE OR MISAPPLICATION OF THE SOFTWARE AND TYPE-
FACES.

New York, U.S.A. law governs this Agreement.

You shall not sublicense, sell, lease, or otherwise transfer the Software and/or Typefaces without the prior written consent of Agfa
Japan.

Use, duplication or disclosure by the Government is subject to restrictions as set forth in the Rights in Technical Data and Computer
Software clause at FAR 252-227-7013, subdivision (b)(3)(ii) or subparagraph (c)(1)(ii), as appropriate. Further use, duplication or
disclosure is subject to restrictions applicable to restricted rights software as set forth in FAR 52.227-19 (¢)(2).

YOUACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT, AND AGREE TOBEBOUND BY ITS
TERMS AND CONDITIONS. NEITHER PARTY SHALL BE BOUND BY ANY STATEMENT OR REPRESENTATION NOT
CONTAINED IN THIS AGREEMENT. NO CHANGE IN THIS AGREEMENT IS EFFECTIVE UNLESS WRITTEN AND
SIGNED BY PROPERLY AUTHORIZED REPRESENTATIVES OF EACH PARTY.

Cautions for Toner Handling

Do not incinerate the toner and toner containers. Dangerous sparks may cause burn.
Never open the toner container or waste toner box.

Make sure not to inhale the toner, and not to rub your eyes or touch your mouth with the hands stained with the toner. And make
sure not to stick to your skin.

For the disposal of old toner container and waste toner box, consult your dealer. Or dispose of the toner or toner containers in
accordance with Federal, State and Local rules and regulations.

Keep away the toner container from children.
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Introduction

The Kyocera Mita page printer has many desirable features, such as EcoPrint function that
reduces the power consumption and Auto Media Type Selection function that selects
automatically media before print.

This section explains the following topics:

* Guide to the Manuals
* Guide to the Operation Guide

Vi



Guide to the Manuals

Item

Description

Installation Guide
(paper manual)

Describes procedures from printer setup to printing a
test page.

Operation Guide Guides you through topics concerning the operations
(this manual) and maintenance of the printer.

PRESCRIBE Programming | Describes how tousethe PRESCRIBE commands and
Manual their parameters in detail for experienced users.

PDF417 Two-Dimensional
Bar Code Implementation
Manual

Includes a PDF417 overview and explains
PRESCRIBE commands for use with two-dimensional
barcodes.

Viii




Guide to the Operation Guide
This Operation Guide guides you through the following topics:

Chapter 1 Using the Operator Panel

This chapter explains the message display, indicators and keys on the
operator panel, and how to make various settings using the operator panel.

Chapter 2 Using the Printer Software

This chapter explains how to install the printer driver, and how to print
from applications.

Chapter 3 Maintenance

This chapter explains how to replace the toner container and how to care
for your printer.

Chapter 4 Troubleshooting

This chapter explains how to handle printer problems that may occur, such
as paper jams.

Chapter 5 Paper Selection
This chapter explains the types of paper that can be used with the printer.

Appendix A Fonts

This appendix explains about and lists the printer’s internal fonts.

Appendix B Options

This appendix explains available options, how to expand the printer’s
memory, and also how to install the memory card and the network
interface card.

Appendix C Host Computer Interface

This appendix describes the pin assignment and specifications for the
printer’s parallel interface, USB interface, and optional serial interface.

Appendix D Printer Specifications

This appendix lists the printer’s specifications.

Appendix E Glossary
This appendix explains the terminology used in this guide.




Chapter 1 Using the Operator
Panel

This chapter explains the following topics:

Understanding the Operator Panel
Using the Operator Panel
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Understanding the Operator Panel

1.1 Understanding the Operator Panel

The operator panel has an LCD message display, 3 LED indicators, and

eight keys.

Message Display

The message display gives information in the form of short messages. The
eight messages listed below are displayed during normal warm-up and

printing.

Other messages, those needing operator attention, are explained in Chapter 4.

Message

Meaning

Self test

The printer is self-testing after power-up.

Please wait

The printer is warming up and is not ready.

Ready

The printer is ready to print.

Processing

The printer is receiving data, generating graphics,
reading a memory card or printing. When the
printer is switched on for the first time after the
toner container is installed, (Adding toner) also
appears.

Sleeping

The printer is in Sleep mode. The printer wakes
from Sleep mode whenever GO key on the operator
panel is pressed, the cover is opened or closed, or
data is received. The printer then warms up and
goes online. The time that the printer takes to enter
Sleep mode depends on the Sleep Timer setting.

Cancelling data

Jobs inside the printer are being cancelled. To
cancel a job, see the table on page 1-5.

Waiting

The printer is waiting for the end-of-job command
before printing the last page. Pressing the GO key
allows you to obtain the last page immediately.

FormFeed TimeOut

The printer is printing the last page after a waiting
period.

Interface Indicator

The LCD message display also shows the interface that is currently used in
the form of the following abbreviations:

PAR Standard bi-directional parallel interface
USB Standard USB interface

SER Optional serial interface (RS-232C)

OPT Optional network interface card

- No interface is active.
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Understanding the Operator Panel

Each interface has a time-out time of 30 seconds during which the other
interface should wait to receive a print job. Even a print job has been
complete on the interface, you should wait for this period until the other
interface begins printing the job.

Paper Size Indicator

The LCD message display also provides information about the paper size of
the paper source. The following abbreviations are used to indicate the
paper sizes.

Message |Paper Size Message |Paper Size
Display Display
A4 ISO A4 (21 x 29.7 cm) EX Executive (7-1/4 x 10-1/2 inches)*
A5 ISO A5 (14.8 x 21 cm) #6 Commercial 6-3/4
(3-5/8 x 6-1/2 inches)”
26 ISO A6 (10.5x 14.8cm)” | #9 Commercial 9 (3-7/8 x 8-7/8 inches)"
B5 JISB5 (18.2 x 25.6 cm) 02 Oficio IT (8-1/2 x 13 inches)*
B6 JISB6(12.8x182cm)" |ST Statement (5-1/2 x 8-1/2 inches)"
LT Letter (8-1/2 x 11 inches) |FO Folio (210 x 330 mm)*
LG Legal (8-1/2 x 14 inches) |HA Japanese Postcard (10 x 14.8 cm)*
MO Monarch ) OH Return Postcard (20 x 14.8 cm)*
(3-7/8 x 7-1/2 inches)"
BU Business ) Y2 Envelope (Youkei 2)
(4-1/8 x 9-1/2 inches)” (114 x 162 mm)"
DL ISO DL (11 x 22 cm)* Y4 Envelope (Youkei 4)
(105 x 235 mm)"
c5 ISOC5(16.2x229cm)” |CU Custom Size
(14.8 x 21 ecm to 21.6 x 35.6 cm)
b5 ISO B5 (17.6 x 25 cm)”

*  With only the MP tray feeding.

While the printer is processing data, the SIZE indicator indicates the
paper size selected by the application software.
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Understanding the Operator Panel

Paper Type Indicator

This shows the paper type defined for the current paper source. Automatic
paper source switching is available according to the paper type.

The paper type can be specified at the operator panel. See Setting the MP
Tray Type on page 1-60 and Setting the Cassette Type on page I1-65.

The following abbreviations are used to indicate the paper type.

Message Display Paper Type Message Display Paper Type
None Auto ROUGH Rough

PLAIN Plain LETTERHEA Letterhead
TRNSPRNCY Transparency* COLOR Color
PREPRINT Preprinted PREPUNCH Prepunched
LABELS Labels* ENVELOPE Envelope*
BOND Bond CARDSTOCK Cardstock*
RECYCLED Recycled CUSTOML (to 8) Custom 1 (to 8)
VELLUM Vellum*

*  With only the MP tray feeding.

Other Indicators

The following indicators light during normal
operation and when the printer needs attention. (READY DATA A1TENT|0N)
Indicator Description
ReAY Flashing: Indicates errors that you can correct yourself.

Lit: Indicates that the printer is online and ready.

Off: Indicates that the printer is offline. The printer can
receive data, but will not print it. The indicator can also signal
that printing has been manually or automatically stopped due
to an error.

DATA Flashing: Indicates a data transfer in process.

© Lit: Indicates either that data is being processed, or that data
is being written to the memory card.

Off: Indicates that the printer is idle.

ATTENTION Flashing: Indicates that paper has run out, that memory is
insufficient, that toner is low or other warning messages.

Lit: Indicates common errors (such as controller errors), when
mechanical maintenanceis needed orindicates a problem that
requires a call to the service center.

Off: Indicates the printer is operating normally.
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Keys

The operator panel keys are used to configure the printer. Note the certain
keys have the secondary function.

A > )

OO0
@@@

MENU ENTER

CANCEL

0 Settings made with these keys affect only the interface currently in use.

Note

Function

+ Switches the printer online and offline (even offline, the printer can receive data).
+ Cancels specific errors.

+ Cancels a printing job.
To cancel, proceed as follows:
1 Make sure if Processing appears on the message display.
2 Press the CANCEL key.
3 Print Cancel? appears on the message display and then interface to be canceled.

Parallel
USB
CANCEL Serial (appears only when an optional serial interface is present)

Option (appears only when an optional network interface card is installed)
Press the CANCEL key again if you wish to stop the cancellation of printing.

4 Select the interface to cancel usingthe A or v key and then press the ENTER key. Printing
from the selected interface will stop. Cancelling data appears in the message display and
printing stops after the current page is printed.

* Resets numeric values or cancels setting procedures.

* When pressed during mode selection, it ends the setting and the printer returns to the Ready
condition.
» Used to select the emulation, font, character code set; to read a memory card; and more.

©

=
m
4
c

Used to access desired items or input numeric values. In some control procedures, the < and >
keys are used to access or exit submenu items.

Used to access desired items or input numeric values. In some control procedures, the < and >
keys are used to access or exit submenu items.

Used as the < key in mode selection.

O <O ©)>

* Used as the > key in the mode selection function.

* Displays online help messages on the message display when paper jam errors occur. When
pressed in the Ready condition, displays explanations of online help messages. When pressed
while the online help is displayed, cancels the online help.

OF
N
“

Confirms numeric values and other selections.

©

ENTER
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1.2 Using the Operator Panel

4

Note

This section explains how to use the menu selection system. The MENU key
on the operator panel allows you to use the menu to set or change the
printer default settings such as the default number of copies, emulation,
etc., to match your specific needs. Settings can be made when Ready is
indicated on the printer message display.

The printer applies the most recent printer settings sent from the
application software or from the printer driver. These take priority over
operator panel settings.

1.2.1 Menu Selection System

The following is the flowchart of the menu selection system of the printer.

Vertical movement between menus is made with the A and v keys and
horizontal movement is made with the > and < keys. To change or confirm
settings of items, use the ENTER key.

Ready
PAR A4 PLAIN

|
©

MENU

Print
Menu Map

Print
Status Page

Continued on next page
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| Continued from previous page I Theitems presented
in shadowed boxes
Interface > >P;£§élel I/F donot appear unless
| PS;;llel TormaT the appropriate
[ Serial g [ High speed 9pt10nalqn1t1s
option [ Nibble (high) installed in the
printer.
>Baud Rate 1
9600 W
L
|
>Data Bits 1
8
L
|
>Stop Bits 1
1
L
|
>Parity I
None
L
>Protocol H
DTR (pos.) &XON
L

>NetWare
Off >>NetWare Frame
[ On : Auto
>TCP/IP
Off >>DHCP
[ On : Oon
>E8?§rTalk >>TP Address
| 000.000.000.000
||
>0Opt. StatusPage >>Subnet Mask
Off 000.000.000.000
T
>>Gateway
000.000.000.000
|
Emulation
PCL
Emulation > >Print KPDL errs
KPDL Off
I [ on
Emulation > >Alt. Emulation
KPDL (AUTO) PCL 6
| X
Emglatlon >Print KPDL errs
Line Printer Off
| On
Emulation

IBM Proprinter

Emulation
DIABLO 630

Emulation
EPSON LQ-850

v

Continued on next page
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Continued from previous page |

Font > >Font Select >
Internal

Option

| ront Select

>> I000

>>Courier
Regular

>Code Set

IBM PC-8 WW
T

T

courier
Dark

>List of
Internal Fonts

>List of
Option Fonts

Page Set

> >Copies
001

>Orientation
Portrait

| Landscape

>Page Protect
Auto

I Oon

>LF Action
LF only

| CcrR and LF B
| Ignore LF

>>Letter Gothic
Regular

Letter Gothic
Dark

>>Size
012.00 point (s)

>>Pitch
10.00 cpi

>CR Action

CR only
| CrR and LF

| Ignore CR

>Wide A4

Off
o ]

Continued on next page
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Continued from previous page |

Print Quality >ﬁ

>KIR Mode
On ]

[ off
|

>EcoPrint Mode
Off

| Oon

>Resolution
Fast 1200 mode

| 300 dpi

| 600 dpi

Opt. ROM

RAM Disk Mode
Off

> ﬂjRead Data |
| >List of

Partitions

Oon

>RAM Disk Size |

>Read Data |

>Write Data

>Delete Data

>List of
Partitions

Memory Card

Continued on next page

>Read Fonts |

>Read Data |

>Write Data

>Delete Data

>Format

Using the Operator Panel

>List of
Partitions
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Continued from Previous page |

Paper Handling > ﬁ

>MP Tray Mode
Cassette

| First

I

>MP Tray Size
A4

>MP Tray Type
Plain

>Cassette Size >
A4

| Custom

>>Un1t

>Cassette Type
Plain

lHCH

>>X Dimension

>Feed Select

Cassette

210mm
|

[ MP Tray

>>Y Dimension
356mm

>Override A4/LT
Off

>Type Adjust
Custom 1

I
—
Ij
]
T
—

>>Paper Weight
Normal

>Reset Type
Adjust

Heavy (Thick)

| Light (Thin)
|

>>Print Density
03

Life Counters >

Continued on next page

>Total Print

>New Toner
Installed




Continued from previous page |
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Others

—

>MSG Language
English

]

>Form Feed
Time Out 030sec.

>Sleep Timer >
005 min.

>>Sleep Mode
Oon

| off °

>Print HEX-DUMP

>Printer Reset

>Resource Prot.
Off

|  Permanent

| Perm / Temp

>Auto Continue

Mode Ooff >>Auto Continue
| Mode on Timer 030sec.
>Service > >>Print

Status Page

]

>>Developer
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1.2.2 Using the Menu Selection System

This section explains the procedure for using the menu selection system.
The menu selection system is activated by the MENU key while the printer
is Ready.

Printing the Menu Map

The printer produces a full list of the menu selection system. Note that
menus indicated on the list may vary depending on which optional units
are installed in the printer.

1

2

Press the MENU key.

Press the A or v key until Print Menu Map appears.

Print
Menu Map

Press the ENTER key. A question mark (?) appears.

Print

Menu Map ?

If you want to abandon this operation, press the CANCEL key.

Press the ENTER key again. The printer prints a menu map.




Sample MENU MAP
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(8 KYOCERA

Ecosrs”)

FS-1050 Page Printer

MENU MAP

[>Paraliel I/F
Auto e

f>>€6ﬁr1er
i Regular

>>Letter Gnth1c '
£L.15 -

[>>pitch

i 10.00 opi

>Code Set
IBM PC-8

>List of
Internal Fonts

> n
LF only
[>CR Actjon
CR on]y
>W1de ‘A4
off

>KIR Mode
Lo

>Resolution
__Fast 1200 mod;

Firmware version:

|#Menu Continued
|

‘#Menu Continued

Released:

>Delete Data | >>Auto Continue

DatasS001 Timer  030sec
[>Format | >Service >
[ i I | ! - .
[List of >>print

| Status Page
’>>Deve1oper

Partitions

‘>HP Tra% Mode

i;ﬁﬁ Tray S!ze

[>MP Tray Type
Pla) y yp

>Cassette Size
A

>Cassette Type
Plain

>Feed Select

| Cassette SRR R,

‘>05erride A/LT

)T(!‘pe Adjust =n
ustom |
>>Paper1welght f

>>Pr1nt Densit
05 v

R eset TYDE
Idj

[>Total Print
| 0000987

| >New Toner
Installed

> SG Language
Engl

>Furm eed

Time Out 030sec.

>Sleep Timer
005 min.

>>S1eep Mode
0ff

[>Print HEX-DUMP

[>Printer Reset

>Resource Prot.
| off

>Read Data
DatasS001

[sWrite Data

| >Auto Continue >
| Mode Off
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Printing a Status Page

If you want to check the printer’s current status, including available
memory and option settings, you can find the information you need on the
status page.

1

2

Press the MENU key.

Press the A or v key until Print Status Page appears.

Print
Status Page

Press the ENTER key. A question mark (?) appears.

Print
Status Page ?

If you want to abandon this operation, press the CANCEL key.

Press the ENTER key. The printer produces a status page.

For a full description of the status page, see the following pages.
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The following is a sample status page. The numbers below correspond to
the explanation numbers.

KYOCER3
{g mifa

S ———

ECOS}S *\ FS-1050 Page Printer

[

i

STATUS( PAGE

Firmware version: Released: priitie I 1
(" Hardwar Info b ] ( Memory W |\
MP Tra{ Letter Plain standard memory 16384 KB
Cassette 1 Ad Plain Option memor{
Slot Emptg
EcoPrint _mode QFF Total | 16384 K
Host buffer size 500 KB User available 4849 KB
Sleep timer 5 Minutes RAM disk OFF
\_FF time out 30 Seconds 7, Hr;te protect Ny
ota
T iy AR N\
7 ""B‘ Information 1 _ User available 0 KB 7,
'd 3t N\
gesa'\unon iast 1200 mode lnﬁ"ﬂd Options ] 5
opies
\& Togﬂ page 122 ) Option ROM NO
i = — T \__Memory card NO
Network Status —— —
S ———— (:Emﬂ!ﬁhn&, I R
Line printer
IBM Progrmter 7
L J Diablo 630
Egson L0-850
PCL 6
\_ KPDL2 v,
/a N
Error Log i
Number  Page Count Description
g 118 Print gverrun 8
& i 112 Memory overflow W,
e ST e N\
Toner Gauge ]
[ i ]
\_ 0 100 )
T = — S
Interfaces i | ]
ki
Parallel Option
PCL 6 Not used
Font
LRl Tome TR
usB
PCL 6
Font
lbyte code Courier
\___Codeset name IBM PC-8 2,
Mode ON 11

( KIR Test pattern

i

o

Note

Items and values on the status page may vary depending on the printer’s
firmware version.
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1 — Software Version

This contains the firmware version and date of issue of the printer.

2 — Hardware Information

This contains information about the printer settings, such as the size and
type of paper in the paper cassette.

3 — Memory

This contains the total amount of memory installed in the printer, the
amount of available memory and the current status of the RAM disk. See
Setting the RAM Disk on page 1-56.

4 — Page Information

This shows the print resolution, number of copies and the total page count.

5 — Installation Options

This shows which options are installed in the printer.

6 — Network Status

This shows the IP address, Subnet Mask address, Default Gateway address,
and other settings for the network interface card installed in the printer.

7 — Emulation

This shows all available emulations of the printer. The default printer
emulation is PCL6.

8 — Error Log

This shows the last three instances of the following six types of errors,
listed in order of occurrence: KPDL Error Press GO;Memory overflow
Press GO; Print overrun Press GO; File not found Press GO;
MemoryCard err Press GO;RAM disk error Press GO. The most
recent error is displayed on the top line of the Error Log. For error
remedies, see Chapter 4. Error information is cleared when the printer’s
power is turned off.

9 — Toner Gauge

This shows the approximate level of remaining toner. When the value is
100, the toner container is full. The closer to 0, the smaller the amount of
remaining toner.

10 — Interface Information

This shows the default font and emulation for all interfaces installed in the
printer.
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11 — KIR Test Pattern

KIR is the Kyocera original smoothing function. This test pattern shows
the effect of the KIR (Kyocera Image Refinement) system.

Changing the Interface Parameters

4l

Note

The printer is equipped with parallel and USB interfaces. In addition, it is
possible to add an optional serial interface to the printer. Various printing
environment parameters such as the default emulation can be changed
independently of the interface by using the printer’s menu selection
system. First, select the interface to which the changes apply using the
procedure described below.

The interface selection described below does not select which interface
data will be received from. The printer automatically selects an interface
from which data is received.

Selecting a Parallel Interface Mode

The parallel interface mode of this printer supports a bi-directional/high-
speed mode. Normally, this interface is used in the Auto mode as default.
For details, see Appendix C. After selecting an interface, reset or restart
the printer. Only after you do this does the change take effect.

1 Press the MENU key.

2 Press the A or v key until Interface > appears. One of the
interface names shown below appears, indicating the current
interface.

Parallel (default)

USB

Serial (option)

Option (with a network interface card installed)

3 Press the ENTER key. A blinking question mark (?) appears.

Interface
2
? Parallel
/|\

If Parallel is not displayed, press the A or v key until Parallel
appears.

If you want to abandon this procedure, press the CANCEL key. The
interface remains unchanged.

4 Press the ENTER key again.
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5 Press the > key. The message display changes to the communication
mode menu.

6 Press the ENTER key. A blinking question mark (?) appears.

iParallel I/F

N
? Auto
/|\

7 Press the A or v key to display the desired mode. The display
changes as shown below. Press the ENTER key.

Auto (default)
Normal

High speed
Nibble (high)

8 Press the MENU key. The message display returns to Ready.

Selecting the USB Interface Mode
About USB interface, for details, see Appendix C.

1 Press the MENU key.

2 Press the A or v key until Interface > appears. One of the
interface names shown below appears, indicating the current
interface.

Parallel (default)

USB

Serial (option)

Option (with a network interface card installed)

3 Press the ENTER key. A blinking question mark (?) appears.

Interface
N,
? Parallel
/|\
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Press the A or v key until USB appears.

Interface
P
? USB
/|\

If you want to abandon this procedure, press the CANCEL key. The
interface remains unchanged.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.

Selecting the Serial Interface Mode

4 This section applies to the printers having the optional serial interface

D board installed.

You can set the baud rate, data bits, stop bits, parity and the protocol for
the serial interface.

1
2

Press the MENU key.

Press the A or v key until Interface > appears. One of the
interface names shown below appears, indicating the current
interface.

Parallel (default)

USB

Serial (option)

Option (with a network interface card installed)

Press the ENTER key. A blinking question mark (?) appears.

Interface
N,
? Parallel
/l\

If you want to abandon this procedure, press the CANCEL key. The
interface remains unchanged.

Press the A or v key until Serial appears.

%nterface

o .
? Serial
/|\




Using the Operator Panel

5 Press the ENTER key again.

6 Press the > key. Each time the A or v key is pressed, the setting
item and current setting change as shown below.

Definable baud rates: 1200, 2400,
>Baud Rate 4800, 9600 (default), 19200, 38400,
9600 57600, 115200
. Definable data bits: 7, 8 (default)
>Data Bits
8
, Definable stop bits: 1 (default), 2
>Stop Bits
1
. Definable parity: None (default), 0dd,
>Parity Even, Ignore
None
Definable protocol: DTR (pos.) §XON
>Protocol (default), DTR (positive), DTR
DTR (pos.) &XON (negative), XON/XOFE, ETX/ACK

7 Display the setting item to be changed and press the ENTER key. A
question mark (?) appears.

The following example shows how to change the baud rate. The
settings for other items can be changed in a similar manner.

>Baud Rate
? 9600

8 Press the A or v key to display the desired setting. The setting
changes as shown below.

The baud rate can be selected from 1200, 2400, 4800, 9600
(default), 19200, 38400, 57600, and 115200.

Some computers may not be compatible with a baud rate of 115200 bps.
If you set the baud rate to 115200 and communication problems occur,
“Note lower the baud rate.
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9 Display the desired baud rate and press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

Selecting Network Interface Parameters

This section applies to the printers having the optional network interface
card installed.

To allow your printer support Netware, TCP/IP and EtherTalk networks,
you will need to install the optional network interface card in your printer
and make the proper adjustments as explained in this section.

You can also have a status page for the network interface card printed out
each time the printer is turned on.

1 Press the MENU key.

2 Press the A or v key until Interface > appears. One of the
interface names shown below appears, indicating the current
interface.

Parallel (default)

USB

Serial (option)

Option (with a network interface card installed)

3 Press the ENTER key. A blinking question mark (?) appears.

Interface
2
? Parallel
/|\

4 Press the A or v key until Option appears.

%nterface

\9/0 )
i ption

5 Press the ENTER key again.
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6

Press the > key. Each time the A or v key is pressed, the display

changes as shown below.

>NetWare >
On

v 4

>TCP/IP >
On

v 4

>EtherTalk
Off

v 4

>Opt.
Off

StatusPage

This is the network interface card
status page print menu. See page 1-24.

The following example explains how to activate the TCP/IP protocol
to be able to connect the printer to a network. You can select
Netware or EtherTalk in a similar manner.

>TCP/IP >
On

If TCP/ 1P is currently Off, select On using the A or v key. Press

the ENTER key again.

>TCP/IP
\'!,O
1S n

>TCP/IP >
= on
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8 Press the > key. Each time the A or v key is pressed, the item
changes as shown below.

>>DHCP
On

v 4

>>TP Address
000.000.000.000

v 4

>>Subnet Mask
000.000.000.000

v 4

>>Gateway
000.000.000.000

9 Display the item to be set and press the ENTER key.
For DHCE a question mark (?) appears. For IP Address, Subnet
Mask, and Gateway, the cursor () blinks.

10 For DHCE select On or Off using the A or v key. For IP Address,
Subnet Mask and Gateway addresses, press A or v key to change
the number (000 to 255) where the cursor is blinking. You can use
the > and < keys to move the cursor right and left.

To obtain these addresses, consult your network administrator.

1 1 Press the ENTER key.

1 2 Press the MENU key. The message display returns to Ready.
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Printing a Network Interface Card Status Page

To use this function, the optional network interface card must be
installed in the printer.

|
2l g

You can print a network interface card status page each time the printer
prints the status page. The network interface card status page shows the
firmware version, the network addresses and other information under
various network protocols about the network interface card. The default is
Off (print).

Printing out a network interface card status page may not be possible
with some network interface cards. For details, see your network
Note interface card manual.

1 Press the MENU key.

2 Press the A or v key until Interface > appears.

Interface >
Parallel

3 Press the ENTER key. A blinking question mark (?) appears.

Interface
N,
? Parallel
/l\

If you want to abandon this procedure, press the CANCEL key. The
interface remains unchanged.

4 Press the A or v key until Option appears.

Interface
\,! ’

,.I\Optlon

5 Press the ENTER key again. A > appears.

Interface >
Option
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6 Press the > key, then the A or v key until the message display
indicates >Opt. StatusPage.

>0Opt. StatusPage
Off

7 The default is Of £. If it is On, change it as follows.
Press the ENTER key. A blinking question mark (?) appears.

>0Opt. StatusPage
o

? On
/l\

8 Select Of f using the A or v key.

?Opt. StatusPage
2 ofE
/l\

9 Press the ENTER key again.

>0Opt. StatusPage
Off

10 Press the MENU key. The message display returns to Ready.
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Sample Network STATUS PAGE

] KYOCERS
Jmita__ ECOSYS °\ FS-1050 Page Printer

B NETWORK STATUS PAGE

IB-20/21 Status and Configuration Summary

General fiost e i e - '
Model: 18-20/21 Default Name KY500036
Firmware Version 3l il 2/10/100 Connection 10BASE-T
Ethernet Address 00:C0:EE:50:00:36 Admin Password Not Defined
TCP/IP o L _ Status: Enabled |
St
IP Address 192.168.1.70 DHCP/BOOTP Disabled
Subnet Mask 255.255.255.0 DHCP Lease None
Default Gateway: 192.168.1.1
WINS Server (Pri.) 192.168.1.2
Host Name: KY500036 WINS Server (Sec.): 0.0.0.0
Port Number 9100 WINS Status Registered
NetBEUI G i i ______ Status: Enabled |
[orios
Printer Name KY500036
Workgroup: TC
Comment 18-20/21
AppleTalk __Status: Enabled |
Printer Name KY500036
Preferred Zone: andromeda
Device Type LaserWriter
NetWare o _IPX/SPX Status: Enabled |
NetWare Name KY500036 Frame Type: 802.2
Mode : Not Detected Network Number: 00001994
Bindery Mode Enabled Queue Polling: 4 seconds
NDS Tree

NDS Context
Bindery Servers: Not Defined

NetWare Connection Status
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The emulation mode for the current interface can be changed from this
menu.

1
2

Press the MENU key.

Press the A or v key until Emulation appears. One of the
emulation names shown below appears, indicating the current
emulation.

PCL 6 (default)
KPDL

KPDL (AUTO)
Line Printer
IBM Proprinter
DIABLO 630
EPSON LQ-850

Press the ENTER key. A blinking question mark (?) appears.

Emulation
oL 6
Ii\

Press the A or v key until the desired emulation mode appears.

If you want to abandon this procedure, press the CANCEL key.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.
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KPDL (AUTO) Emulation

KPDL is Kyocera Mita’s implementation of the PostScript language. The
KPDL (AUTO) emulation enables the printer to automatically change
emulation mode according to the data received when printing.

In addition to the KPDL (AUTO) emulation, you can use the operator panel
to select other frequently used emulation modes. The default is PCL 6.

1
2

Press the MENU key.

Press the A or v key until Emulation appears.

Emulation
PCL ©

Press the ENTER key. A blinking question mark (?) appears.

Emulation
P

?PCL ©

?l\

Press the A or v key until KPDL (AUTO) appears.

?mulation
nL,

?KPDL (AUTO)
?l\

If you want to abandon this procedure, press the CANCEL key.

Press the ENTER key.

Press the > key. Press the A or v keyuntil >Alt. Emulation
appears. The names of alternative emulations appear.

Press the ENTER key. A blinking question mark (?) appears.

?Alt. Emulation
v
'??CL o
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8 Press the A or v key until the desired emulation appears.

PCL 6 (default)
Line Printer
IBM Proprinter
DIABLO 630
EPSON LQ-850

If you want to abandon this procedure, press the CANCEL key.

9 Press the ENTER key.

10 Press the MENU key. The message display returns to Ready.

Printing a KPDL Error Report Automatically

You can print a KPDL error report automatically when this type of
emulation is in use. If the function is On, the printer produces error
information only when trouble occurs during printing. The default is Of .

1 Press the MENU key.

2 Press the A or v key until Emulation appears.

Emulation
PCL ©

3 Press the ENTER key. A blinking question mark (?) appears.

Emulation
MhoL 6
bis

4 Select KPDL or KPDL, (AUTO) using the A or v key.

Emulation
z,

?KPDL
ll\

If you want to abandon this procedure, press the CANCEL key.

5 Press the ENTER key.
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6 Press the > key. The message display changes to that shown below. If
>Alt. Emulation is displayed when the KPDL, (AUTO) emulation
is selected, press the A or v key to change it.

>Print KPDL Errs
Off

7 Press the ENTER key. A blinking question mark (?) appears.

?Print KPDL Errs
SV

? Off

?l\

8 Select On using the A or v key.

?Print KPDL Errs
SV
2

'i\On

If you want to abandon this procedure, press the CANCEL key.

9 Press the ENTER key.

10 Press the MENU key. The message display returns to Ready.
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You can select the font to be used by default with the current interface. In
addition to the internal fonts, all fonts downloaded to the printer memory,
the memory card or optional ROM can be selected as the default font.

From this menu, you can also select the type and pitch for Courier and
Letter Gothic, the size of the default font, as well as print a font list.

Selecting the default font

1
2

Press the MENU key.

Press the A or v key until Font > appears.

Font >

Press the > key. Press the A or v key until > Font Select >
appears.

>Font Select >
Internal

To select an internal font, make sure that Internal is displayed and
press the > key. The message display changes as shown below. If
Internal is not displayed, press the A or v key to display it.

>> T000

To select an option font, press the ENTER key while > Font Select
> is displayed. Press A or v key until the message display indicates
Option and press the ENTER key. Pressing the > key after that
displays the font selection shown above. This operation is possible
only when option fonts are installed in the printer.

The letter before the number indicates the type of font as shown
below:

Letter Description

I Internal font

S Soft (downloaded) font

M Fonts in a memory card

H Fonts in a RAM disk.

0 Fonts in an optional ROM
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7
8

Press the ENTER key. A blinking question mark (?) appears.

]
>>27000
/l\

Press the A or v key until the desired font number appears. For
the numbers of internal fonts, see List of Fonts on page A-3.

If you want to abandon this procedure, press the CANCEL key.

When the desired font is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.

Selecting a Courier/Letter Gothic Type

The Courier and Letter Gothic font can be either Regular or Dark. For
example, to change the Courier type, proceed as follows:

1
2

Press the MENU key.

Press the A or v key until Font > appears.

Font >

Press the > key. Press the A or v key until > Font Select >
appears.

>Font Select >
Internal

Make sure that Internal is displayed and press the > key.

Press the A or v key until >>Courier appears.

>>Courier
Regular
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6 Press the ENTER key. A blinking question mark (?) appears.

?>Courier

\’;/R 1
I eguLlar
?l\ 9

7 Select Regular or Dark using the A or v key.

If you want to abandon this procedure, press the CANCEL key.
8 Press the ENTER key.

9 Press the MENU key and the message display returns to Ready.

Changing the Font Size

You can change the size of the proportional fonts. If the default font is a
fixed font such as Courier or Letter Gothic, the character pitch can be
changed instead of the font size.

1 Press the MENU key.

2 Press the A or v key until Font > appears.

Font >

3 Press the > key. Press the A or v key until > Font Select >
appears.

>Font Select >
Internal

4 Make sure that > Font Select > is displayed and press the > key.

5 Press the A or v key until >>Size appears.

>>Size
012.00 point(s)
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8
9

Press the ENTER key. A blinking cursor (_) appears.

>>Size
012. O‘b'point (s)
LA

Press the A or v key to increase or decrease the value where the
cursor is blinking. The font size can be set between 4 and 999.75
points, in 0.25-point increments. You can use the > or < key to move
the cursor right and left.

If you want to abandon this procedure, press the CANCEL key.

When the desired size is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.

Changing the Character Pitch for Courier/Letter Gothic

You can change the character pitch for fixed fonts when the default font is
Courier or Letter Gothic.

1
2

Press the MENU key.

Press the A or v key until Font > appears.

Font >

Press the > key. Press the A or v key until > Font Select >
appears.

>Font Select >
Internal

Make sure that Tnternal is displayed and press the > key.

Press the A or v key until >>Pitch appears.

>>Pitch
10.00 cpi
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Press the ENTER key. A blinking cursor (_) appears.

>>Pitch

1
10.\0, .

Cp1l
IT\p

Press the A or v key to increase or decrease the value where the
cursor is blinking. The character pitch can be set between 0.44 and
99.99 characters per inch, in 0.01 character-per-inch increments. You
can use the > or < key to move the cursor right and left.

If you want to abandon the setting procedure, press the CANCEL
key.

When the desired pitch is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.

Selecting the Code Set

You can change the character code set. Available character code sets vary
depending on the current font. (The default is IBM PC-8.)

1
2

Press the MENU key.

Press the A or v key until Font > appears.

Font >

Press the > key. Press the A or v key until > Code Set appears.

>Code Set
IBM PC-8

Press the ENTER key. A blinking question mark (?) appears.

>Code Set
N,
?IBM PC-8
/|\
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6
7

Press the A or v key until the desired character code set appears.

If you want to abandon this procedure, press the CANCEL key.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.

Printing a List of Fonts

To help in selecting fonts, you can print lists of all the fonts currently
available to the printer.

1
2

Press the MENU key.

Press the A or v key until Font > appears.

Font >

Press the > key.

Press the A or v keyuntil >L.ist of Internal Fontsor >List
of Option Fonts appears.

>List of
Internal Fonts

Press the ENTER key. A question mark (?) appears.

>List of
Internal Fonts?

If you want to abandon this procedure, press the CANCEL key.

Press the ENTER key again. Processing appears, then Ready. The
printer prints a list of fonts, each with a short sample and font ID
(number).
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List of Fonts

calable and Bitmap
Font Name r i I [“Password ] [ selection _(FSETI FotD ]|
Helvetica-Nr <Scalable> None FSET 1p##vis0b24580T; T041 |
Helvetica-NrBd <Scalabl ‘ _ FsET i 1042
1043
1044
*?"fit" ?“:,:;%&‘l.z«»ﬁ'g s lise i | o
alabl s ‘ﬁ!n“"‘“ﬁm iz i - 1046
1047
Font Name ]| ] [ Password | \ Selection _[FSET] FontD | s
Courier <scalable> None FSET 0p##h0s0b4099T; 1000 Toss
CGTimes <Scalables> None FSET 1pk#v0s0ba101T; 1001 : e
CGTimes-Bd <Scalable> None FSET 1pi#v0s3b4101T; 1002 1051
CGTimes-It N FEET 1017 1003 1052
CGTimes-Bdlt <Scalable> None FSET 1p##v1s3be101T; 1004 1053
CGOmega <Scalable> None FSET 1p##v0s0bdlldT; 1005 s
CGOmega-Bd <Scalable> None FSET 1p##v0s3ba113T; 1006 1055
CGOmega-lt <Scalable> None PSET 1pH#vis0ba113T; 1007 ive
CGOmega-Bdit <Scalables None FSET 1pivia3baiist; To08 Lo57
Coronat <Scalable> None FSET 1p#¥vis0be116T; 1003 Sidi
Clarendon-Cd <Scalable> None FSET 1ph#vas3bel40T; 1010 T0ss
Univers-Md <Scalables None PSET 1pk#v0s0b4l48T; 1011 z hse
Univers-Bd <Scalables None FSET 1p##v0s3b4148T; 1012 I Lot
Univers-Mdlt N PSET 1013 06
Univers-Bdit <Scalable> i None PSET 1ph#v1s3ba148T; 1014 1063
Univers-MdCd <Scalables None FSET 1pkkv4s0b4148T; 1015 1084
Univers-BdCd <scalables None FSET 1phivas3balast; 016 Loes
Univers-MdCdlt <Scalables None . FSET 1pk#vSs0be14sT; 1017 cener 1066
Univers-BdCdlt <Scalable> None FSET 1p#v5s3ba148T; 1018 saser;  Tog7
AntiqueOlive <Scalable> None FSET 1pk#v0s0DA166T; 1013 e
Antiqueolive-Bd <scalables None FSET 1p#kv083ba168T; 1020 si0m 1069
AntiqueOlive-It <Scalable> Nene FSET 1p#kv1s0b4168T; 1021 s
GaramondAntiqua <Scalables None FSET 1pkivos0ba197T; 1022 on
Garamond-HIb <Scalables None FSET 1ph#v083ba137T; 1023 s
Garamond-Krsv <Scalable> None FSET 1pH#v1s0b4197T; 1024 073
Garamond-HIbKrsv <Scalable> None FSET 1phivia3bal197T; 1028 074
Margod <scalable> None FSET 1p##v0s0b4297T; 1026 1075
Albertus-Md <Scalables None. FSET 1piiv0s1be36aT; 1027 zize
Albertus-ExtBd <Scalable> None PSET 1pi#v0s4ba362r; 1028 1017
Arial <Scalables None FSET 1p##v0s0b16602T; 1029 o
Arial-Bd <Scalable> None FSET 1p##v083b16602T; 1030 1079
Arial-lt <Scalable> None FSET 1ph#v1s0b16602T; 1031 i
Arial-Bdit <Scalable> None FSET 1pi#v1s3bl66027; 1032
TimesNewRoman <Scalable> None FSET 1phiv0s0b16901T; 1033
TimesNewRoman-Bd <Scalable> None PSET 1pk#v0s3b16901T; 1034
TimesNewRoman-It <Scalables None PSET 1pi#v1e0b16901T; 1035
| TimesNewRoman-Bdlt <Scalable> None FSET 1p##v1s3bl6901T; 1036
‘ Helvetica <Scalable> None FSET 1pkkv080b24580T; 1037
Helvetica-Bd <Scalable> None FSET 1pk#v0s3b24580T; 1038
Helvetica-Ob <scalables None FSET 1pHivis0b24580T) 1039
| Helvetica-BdOb <scalable> None FSET 1ph#v1s3b24580T; 1040
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Using Page Set Menus

In the Page Set menus, you can change the number of copies, the page
orientation and other settings that have to do with pages.

Changing the Number of Copies

You can change the number of copies to be printed for the current interface.
The number of copies can be set between 1 and 999. You can change this
number whenever the message display indicates Ready.

1
2

Press the MENU key.

Press the A or v key until Page Set > appears.

Page Set >

Press the > key.

Press the A or v key until >Copies appears.

>Copies
001

Press the ENTER key. A blinking cursor (_) appears.

>Copies

ool

Press the A or v key to increase or decrease the value where the
cursor is blinking. It can be set between 1 and 999. You can use the >
and < keys to move the cursor right and left.

If you want to abandon this procedure, press the CANCEL key.

When the desired value is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Selecting the Printing Orientation

You can select between portrait (upright) or landscape (sideways) page
orientation. You can change the page orientation whenever the message
display indicates Ready.

A < Paper feed direction

Portrait Landscape
(default)

1 Press the MENU key.

2 Press the A or v key until Page Set > appears.

Page Set >

3 Press the > key.

4 Press the A or v key until >0rientation appears.

>0Orientation
Portrait

5 Press the ENTER key. A blinking question mark (?) appears.

>0Orientation
zo

5 .
q\Portralt

6 Select Portrait or Landscape using the A or v key.

If you want to abandon this procedure, press the CANCEL key.
7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.
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Page Protect Mode

Although Auto is the default setting and this menu does not usually
appear, Page Protect will automatically be set to Onifa Print overrun
Press GO error occurs because the data transferred to the printer is too
complex to print on a page. Be sure to return this setting to Auto in order
to maintain peak printer memory efficiency. You can do this as follows.

1 Press the MENU key.

2 Press the A or v key until Page Set > appears.

Page Set >

3 Press the > key.

4 Press the A or v key until >Page Protect appears.

>Page Protect
On

5 Press the ENTER key. A blinking question mark (?) appears.

>Page Protect
Mo

? On
?l\

6 Press the A or v key until Auto appears.

?Page Protect

no
? Auto
?l\

If you want to abandon this procedure, press the CANCEL key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.
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Linefeed (LF) Action

This procedure instructs the printer as to what to do when it receives a line
feed code (character code 0AH).

1 Press the MENU key.

2 Press the A or v key until Page Set > appears.

Page Set >

3 Press the > key.

4 Press the A or v key until >LF Action appears.

>LF Action
LF only

5 Press the ENTER key. A blinking question mark (?) appears.

?LF Action

M 1
ﬁ\LF only

6 Press the A or v key until desired line feed action appears.

LF only The printer performs a line feed. (Default)

CR and LF  The printer performs a line feed and a carriage
return.
Ignore LF  The printer ignores the line feed.

If you want to abandon this procedure, press the CANCEL key.

7 When the desired action is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.
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Carriage-Return (CR) Action

This procedure instructs the printer as to what to do when it receives a
carriage-return code (character code 0DH).

1 Press the MENU key.

2 Press the A or v key until Page Set > appears.

Page Set >

3 Press the > key.

4 Press the A or v key until >CR Action appears.

>CR Action
CR only

5 Press the ENTER key. A blinking question mark (?) appears.

?CR Action
S
ﬁ\CR only

6 Press the A or v key until desired carriage-return action appears.

CR only The printer performs a carriage-return. (Default)

CR and LF  The printer performs a carriage-return and a line
feed.
Ignore CR  The printer ignores the carriage-return code.

If you want to abandon this procedure, press the CANCEL key.

7 When the desired action is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.
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Wide A4

Turn this to On to increase the maximum number of characters that you
can print on a line of an A4 page (78 characters at 10 pitch) or a Letter size
page (80 characters at 10 pitch). This feature is only effective with the PCL
6 emulation.

1
2

Press the MENU key.

Press the A or v key until Page Set > appears.

Page Set >

Press the > key.

Press the A or v key until >Wide A4 appears.

>Wide A4
Off

Press the ENTER key. A blinking question mark (?) appears.

>Wide A4
no

? Off
?l\

Select On or Of £ (default) using the A or v key.

If you want to abandon this procedure, press the CANCEL key.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.

1-43



Using the Operator Panel

Improving the Print Quality

Note

You can adjust a variety of features to enhance the quality of your
printouts with the printer. First, you can use the Kyocera Image
Refinement (KIR), a software algorithm designed to increase the quality of
your printouts. Also, activating the EcoPrint printing mode reduces toner
consumption during printing. Finally, you can adjust the printing
resolution and density.

KIR (Kyocera Image Refinement)

This printer incorporates the KIR (Kyocera Image Refinement) smoothing
function. KIR uses software to enhance resolution, resulting in high-
quality printing at resolution of 600 dpi and 300 dpi. The default is On.

With KIR Of £ With KIR On (default)

Set the print density to 3 when setting the KIR mode. For details on print
density, see Adjusting the Print Density on page 1-71.

You can look at the check line, the last line on a status page, to make the
optimum KIR mode setting.

Status Page el e

[

——wee e oo

KIR Check -

Lines

Optimized stripes
The current KIR setting is optimal.

Dark vertical stripes

Turn the KIR mode Of £. Try printing a status page again. If you still
get dark vertical stripes, adjust the print density control to a lighter
setting.

White vertical stripes

Turn the KIR mode On. Try printing a status page again. If you still

get white vertical stripes, adjust the print density control to a darker
setting.
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Press the MENU key.

Press the A or v key until Print Quality > appears.

Print Quality >

Press the > key.

Press the A or v key until >KIR Mode appears.

>KIR Mode
On

Press the ENTER key. A blinking question mark (?) appears.

>KIR Mode
s!}/o
ri\ n

Select On or Of f using the A or v key.

If you want to abandon this procedure, press the CANCEL key.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.
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EcoPrint

EcoPrint allows you to reduce the amount of toner the printer uses per
page. This helps save on printing costs. You can activate EcoPrint as
follows. (The default is Of f.)

The EcoPrint mode setting is On when the printing image becomes lighter,
yet stays very readable.

3

4
EcoPrintis Of £ EcoPrint is On
(default).

( 7 The EcoPrint setting has no effect on the print speed.
“Note

1 Press the MENU key.

2 Press the A or v key until Print Quality > appears.

Print Quality >

3 Press the > key.

4 Press the A or v key until >EcoPrint Mode appears.

>EcoPrint Mode
Off

5 Press the ENTER key. A blinking question mark (?) appears.

?EcoPrint Mode
zo
ﬁ\Off

6 Select On or Of f using the A or v key.

If you want to abandon this procedure, press the CANCEL key.
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Press the ENTER key.

Press the MENU key. The message display returns to Ready.

Resolution

You can choose one of the three following resolutions — Fast 1200 mode
(default), 300 dpi and 600 dpi. The clarity of printed characters and
graphics becomes sharper in this order.

1
2

Press the MENU key.

Press the A or v key until Print Quality > appears.

Print Quality >

Press the > key.

Press the A or v key until >Resolution appears.

>Resolution
Fast 1200 mode

Press the ENTER key. A blinking question mark (?) appears.

?Resolution

V4
~? Fast 1200 mode
ll\

Select Fast 1200 mode, 300 dpior 600 dpi using the A or v
key.
If you want to abandon this procedure, press the CANCEL key.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Operating a Memory Card (CompactFlash Card)

The printer is equipped with a slot for a memory card (CompactFlash
card), which allows you to perform the following operations.

*Reading fonts

*Reading data

*Writing data

*Deleting data

*Formatting a memory card

*Printing a list of data names

When installing or removing a memory card into or from the printer, you
must turn the printer power switch off. Failure to do so will immediately

halt the printer with a Memory card err20 message. It could also result
in damage to the printer’s electronic parts or the memory card.

Reading Fonts

When there are fonts present on the memory card inserted in the slot, they
are automatically read into the printer when it is turned on.

To re-read fonts from a memory card into the printer, proceed as follows.
1 Press the MENU key.

2 Press the A or v key until Memory Card > appears.

Memory Card >

3 Press the > key.

4 Press the A or v key until >Read fonts appears.

>Read fonts

5 Press the ENTER key. A question mark (?) appears.

>Read fonts ?
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6 Press the ENTER key. Processing appears and the font reading
from the memory card starts.

If you want to abandon this procedure, press the CANCEL key.

7 When the reading of fonts ends, the message display returns to
>Read fonts.

8 Press the MENU key. The message display returns to Ready.

Reading Data

Data stored on a memory card can be read. To read it, proceed as follows.

1 Press the MENU key.

2 Press the A or v key until Memory Card > appears.

Memory Card >

3 Press the > key.

4 Press the A or v key until >Read Data appears. The data name
also appears.

>Read Data
DataS001

5 Press the ENTER key. A blinking question mark (?) appears before
the data name.

?Read Data
no
";pataSOOl

6 Press the A or v key to display the desired data name.

If you want to abandon this procedure, press the CANCEL key.

7 Press the ENTER key. Processing appears and the reading of data
from the memory card starts.
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Writing Data

Data can be written on a memory card until it is full. When writing data on
a memory card, a name is automatically assigned to the file. You can use
the procedure explained further in this section to print a list of file names
for confirmation.

To write data on a memory card, proceed as follows.

1
2

Press the MENU key.

Press the A or v key until Memory Card > appears.

Memory Card >

Press the > key.

Press the A or v key until >Write Data appears.

>Write Data

Press the ENTER key. A question mark (?) appears.

>Write Data °?

Press the ENTER key. Processing appears, then Waiting.

If you want to abandon this procedure, press the CANCEL key.

In this state, send the file from the computer to the printer as in the
example below.

Example:

To send the file (data) 7EST'7XT on drive C, enter the following from
the DOS prompt (C:\):

COPY TEST.TXT PRN

The file is written into the memory card and is given a destination
name (also referred to as a partition name) which the printer
automatically assigns in a logical order as follows:
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DataS001 (first data), DataS002 (second data),
DataS003 (third data)...

In the example above, if the file TEST TXT'is the first data to be
written onto the memory card, the destination name will be
DataS001.

As the printer receives data, the message display changes to
Processing, then when the end of the data is received, the message
display changes to Waiting.

Make sure that the message display changes to Waiting, then press
the GO key. This has the effect of writing the file into the memory
card and instructs the printer to print a memory card WRITE
INFORMATION page as shown below.

(] KYOCERE
Jnita__ ECOSYS °\ FS-1050 Page Printer

| WRITE INFORMATION

MEMORY CARD/A
ZlPrmtable Duta
DataS001 ISystem daﬂna
69 bytes

Partition Type. Type of data written (currently only type 2 is supported).
Partition Name. The destination name of data written on the card.
Write Partition Length. The size of the data written on the memory card.
Others. Error information.

After the memory card WRITE INFORMATION page is printed, the
message display returns to Ready.

If the writing procedure is not successfully completed, an error code
appears on the message display. For details, see section 4.3.3 Errors
Messages on page 4-9. If this happens, press the GO key. The
message display returns to Ready.

Repeat the steps above until you have transferred all the data (files)
you want to write on the memory card. Each time you finish writing
data, a memory card Write Information page is printed, which
contains the information explained in step 8 above, but pertaining
only to the data just written. To see all data contained in the memory
card at once, print a list of data names as explained on page 1-54,
Printing a List of Data Names.
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Deleting Data

It is possible to use the printer to delete data from a memory card, one file
at a time. To delete data from a memory card, proceed as follows, but first
make sure that the memory card contains data. If it does not contain any
data, the >Delete Data menu does not appear on the message display.

1 Press the MENU key.

2 Press the A or v key until Memory Card > appears.

Memory Card >

3 Press the > key.

4 Pressthe A or v keyuntil > Delete Data appears. The data name
also appears.

>Delete Data
DataS001

5 Press the ENTER key. A blinking question mark (?) appears before
the data name.

?Delete Data
no
ﬁpataSOOl

6 Press the A or v key to display the desired data name.

If you want to abandon this procedure, press the CANCEL key.

7 Press the ENTER key. Processing appears and the data is deleted
from the memory card.
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Formatting a Memory Card

Formatting allows data to be written to the memory card. A new memory
(CompactFlash) card must be formatted before it can be used in the printer.
* Formatting destroys any existing data on the memory card.

* When installing or removing a memory card into or from the printer,
you must turn the printer power switch off. Failure to do so will
immediately halt the printer with a Memory card err20 message. It
could also result in damage to the printer’s electronic parts or the
memory card.

To format a memory card, proceed as follows.

1 Press the MENU key.

2 Press the A or v key until Memory Card > appears.

Memory Card >

3 Press the > key.

4 Press the A or v key until >Format appears.

>Format

5 Press the ENTER key. A question mark (?) appears.

>Format ?
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Press the ENTER key. Processing appears and formatting of the
memory card starts.
If you want to abandon formatting, press the CANCEL key.

When the formatting is successfully completed, the printer
automatically prints out a Format Information page as shown below.

O KYDCERE
ﬂ/ ECOSYS °\ FS-1050 Page Printer
= FORMAT INFORMATION g

Device ltiamelNumi?er: MEMORY CARD/A
Formatting is completed. ‘

Copaditv: v L 16007168 bytes
Used Space: 57344 bytes
Free Space: i 15949824 bytes

Capacity. The total size of the memory card memory.

Used Space. The size the printer uses for its system.

Free Space. The size remaining in the memory card for storing data.

When the memory card format information is printed, the message
display returns to Ready.

Printing a List of Data Names

You can print a list of all data names (also know as partitions) stored in
memory for reference. (Printing a list is also available for a font card.)

To print a complete list of data names for the memory card, proceed as
follows.

1
2

Press the MENU key.

Press the A or v key until Memory Card > appears.

Memory Card >

Press the > key.

Press the A or v key until >List of Partitions appears.

>List of
Partitions
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Press the ENTER key. A question mark (?) appears.

>List of
Partitions ?

If you want to abandon this procedure, press the CANCEL key.

Press the ENTER key. Processing appears and printing of the list
starts.

t] KYOCERA
Jita__ ECosrs' FS-1050 Page Printer
[ PARTITION LIST
'  Devi Information
Write Protect: DISABLED

ST __Partition Information ' i

Partition Name Partition Size Partition Type

DataS001 69 Printable Data

\_///\

The printout (example above) includes the following information.

Device Name/Number. CARD/A is indicated for the memory card.

Capacity. The total memory of the card, in bytes.

Used Space. The total size of data stored on the memory card, in bytes.

Free Space. The total remaining memory capacity of the card, including the
amount of memory the printer uses for its system.

Partition Name. The name of the data as assigned by the printer.

Partition Size. The size of the data, in bytes.

Partition Type. The type of the data, i.e. whether it is host data (Data) or font
data (Font).

After the list of data names (PARTITION LIST) for the memory card is
printed, the message display returns to Ready.
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Setting the RAM Disk

Note

The RAM disk is a portion of the printer’s memory that is shared and can
temporarily store print jobs. The RAM disk can only be used for electronic
sorting. Print jobs stored in the RAM disk can then be used to accelerate
multiple copy print jobs, for example. The data contained in the RAM disk
remains there only while the printer is on.

The maximum size of RAM disk should be calculated as follows:
Maximum RAM size = Total printer memory - 9 MB

For example, if the total memory installed in your printer is 16 MB, you
can adjust the RAM disk size to 7 MB, as outlined below. If you try to set
the RAM disk size beyond this restriction, the printer automatically rounds
the value down to the appropriate size. Once the RAM disk size is set, you
need to reset the printer.

To activate the RAM disk in the printer’s memory, you must first use the
printer’s menu selection system.

The printer’s menu selection system allows you to perform the following
operations.

*Setting the RAM disk size
*Reading data

*Writing data

*Deleting data

*Printing a list of data names

The procedures are the same as that for the Memory Card menu. See
Operating a Memory Card (CompactFlash Card) on page 1-48 The
procedure to activate and set the function follows.

The RAM disk is set from the printer’s user memory. Therefore, the
printing speed can drop and/or insufficient memory errors occur,
depending on the settings for the RAM disk.

1 Press the MENU key.

2 Press the A or v key until RAM Disk Mode appears.

RAM Disk Mode
Off
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3 The default is Of £. Press the ENTER key. A blinking question mark
(?) appears. Select On using the A or v key then press the ENTER
key.

RAM Disk Mode
s!}/o
ri\ n

4 Press the > key to display >RAM Disk Size.

>RAM Disk Size
0007 Mbyte

5 Press the ENTER key again. A blinking cursor () appears. Change
the RAM disk size using the A or v key. It is not possible to make a
setting that exceeds total printer memory. The default value for the
RAM disk is the total printer memory minus 9 MB. This parameter
may be set anywhere from 01 to 135 depending on the available
printer memory.

If you want to abandon this procedure, press the CANCEL key.

6 When the desired RAM disk size is displayed, press the ENTER key.

7 Press the MENU key and restart the printer. The setting will take
effect after restart.

You can change the MP tray mode, the paper size and type for each paper
source, the paper source and paper destinations.

MP Tray Mode

The MP tray can be used in one of two modes: first mode or cassette mode.
The MP tray can hold approximately 50 sheets of paper (A4 size, 0.11 mm
thickness).

First Mode (Automatic Manual Feeding)

The printer automatically feeds the paper from the MP tray even if another
paper source is selected. After all the paper in the MP tray is used, paper
will be fed from the paper source originally selected.
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Cassette Mode

Printing in Cassette Mode is faster than in First Mode. Approximately 50
sheets can be fed continuously when in this mode. (This is the default.)

1 Press the MENU key.

2 Press the A or v key until Paper Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key until >MP Tray Mode appears.

>MP Tray Mode
Cassette

5 Press the ENTER key. A blinking question mark (?) appears.

?MP Tray Mode
N

? Cassette
I|\

6 Select First or Cassette using the A or v key.

If you want to abandon this procedure, press the CANCEL key.
7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.
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Setting the MP Tray Size

When using the MP tray in the Cassette mode, you should set the MP tray
size to the paper size used for print jobs. If they do not match, the printer
does not print on the correct size paper if the automatic selection of the
paper size is made by the application (printer driver). The default is A4.

For more details about paper sizes that can be fed from the MP tray, see
Chapter 5.

Feeding the paper having a paper size which does not match the current
paper size from the MP tray can cause paper jam.

1 Press the MENU key.

2 Press the A or v key until Paper Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key until >MP Tray Size appears.

>MP Tray Size
A4

5 Press the ENTER key. A blinking question mark (?) appears.

>MP Tray Size
N

? A4

I|\

6 Press the A or v key to display the desired MP tray size. The
display changes as shown below.

A4
Executive
Letter
Legal
Custom
Oficio II
Statement
Folio
Youkei 2
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Youkei 4
Hagaki
OufukuHagaki
Monarch
Business
Comm. #9
Comm. #6 3/4
DL

C5

A6

B6

A5

B5

ISO B5

If you want to abandon this procedure, press the CANCEL key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

Setting the MP Tray Type

You can automatically select the paper cassette according to the selection
made by the application (printer driver). The factory default setting is
Plain.

For more details about the paper types that can be fed from the MP tray,
see Chapter 5.

1 Press the MENU key.

2 Press the A or v key until Paper Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key until >MP Tray Type appears.

>MP Tray Type
Plain
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Press the ENTER key. A blinking question mark (?) appears.

?MP Tray Type

nNo .
? Plain
I|\

Press the A or v key to display the desired MP tray type. The
display changes as shown below.

Plain
Transparency
Preprinted
Labels

Bond
Recycled
Vellum

Rough
Letterhead
Color
Prepunched
Envelope
Cardstock
Custom 1 (to 8)

If you want to abandon the selection, press the CANCEL key.

When the desired MP tray type is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Setting the Cassette Size

After setting the paper into the paper cassette, you should set the cassette
size as follows. The default factory setting is A4.

About the paper cassette, and the adjustment of the paper guides and
paper stopper inside the paper cassette, see the Installation Guide supplied
with the printer.

1 Press the MENU key.

2 Press the A or v key until Paper Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key until >Cassette Size appears.

>Cassette Size
A4

5 Press the ENTER key. A blinking question mark (?) appears.

>Cassette Size
N o

? A4

I|\

6 Press the A or v key to display the desired cassette size. The
display changes as shown below.

A4
Letter
Legal
Custom
A5

B5

If you want to abandon the selection, press the CANCEL key.

7 When the desired cassette size is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.
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Setting the Custom Paper Size

In addition to the standard A5, A4, B5, Letter and Legal sizes for the paper
cassette, paper of other sizes can be used as custom sizes. When placing
paper of sizes other than A5, A4, B5, Letter or Legal size into the paper
cassette, set the custom size of the paper to be used by following the
procedure given below.

Properly set the paper into the paper cassette. For details about the
adjustment of the paper guides and paper stopper inside the paper
cassette, see the Installation Guide supplied with the printer.

1 Press the MENU key.

2 Press the A or v key until Paper Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key until >Cassette Size appears.

If an option paper feeder is added, >Cassette 1 Size will appear
for the standard paper cassette and >Cassette 2 Size will appear
for the option paper feeder.

>Cassette Size
A4

5 Press the ENTER key. A blinking question mark (?) appears.

>Cassette Size
N o

? A4

I|\

6 Press the A or v key until Custom appears.

?Cassette Size

N
? Custom
I|\

7 Press the ENTER key.
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10

11

12
13

14

15

16

Press the > key.

Press the A or v key until >>Unit appears. The unit of
measurement can be selected between millimeters and inches. The
current unit of measurement is displayed (the default setting is mm ).

>>Unit
mm

Press the ENTER key. A blinking question mark (?) appears.

>>Unit
N

?
l|\

Select mm or inch using the A or v key.

If you want to abandon the selection, press the CANCEL key.

Press the ENTER key.

When the unit of measurement is set, press the v key. >>X
Dimension appears as shown below (the paper width setting).

>>X Dimension
210 mm

Press the ENTER key. A blinking cursor (_) appears.

>>X Dimension
\l,

210 mm
IT\

Press the A or v key to increase or decrease the value of the figure
where the cursor is blinking and display the desired width. The
width can be set between 148 and 216 mm (5. 83 to 8.5 inches). You
can use the > and < keys to move the cursor right and left.

If you want to abandon the selection, press the CANCEL key.

Display the desired paper width and press the ENTER key.
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17 When the width is set, press the v key. >>Y Dimension appears
(the paper length setting). Set the desired length in the same way as
the width. The length can be set between 210 and 356 mm (8.27 to
14.02 inches).

>>Y Dimension
356 mm

1 8 Display the desired paper length and press the ENTER key.

19 Press the MENU key. The message display returns to Ready.

To print using the custom size set above, define the same custom size
on the printer driver.

Setting the Cassette Type

You can automatically select the paper cassette according to the selection
made by the application (printer driver). The factory default setting is
Plain.

For more details about the paper types that can be fed from the paper
cassette, see Chapter 5.

1 Press the MENU key.

2 Press the A or v key until Paper Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key until >Cassette Type appears.

If an option paper feeder is added, >Cassette 1 Type will appear
for the standard paper cassette and >Cassette 2 Type will appear
for the option paper feeder.

>Cassette Type
Plain
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5 Press the ENTER key. A blinking question mark (?) appears.

?Cassette Type
S

? Plain

71

6 Press the A or v key to display the desired cassette type. The
display changes as shown below.

Plain
Preprinted
Bond
Recycled
Rough
Letterhead
Color
Prepunched
Custom 1 (to 8)

If you want to abandon the selection, press the CANCEL key.

7 When the desired cassette type is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.

Selecting the Paper Source

You can select from which paper source printing will be performed. The
selections are the paper cassette and MP tray of the printer. This menu
changes slightly if there is an option paper feeder present.

1 Press the MENU key.

2 Press the A or v key until Paper Handling > appears.

Paper Handling >

3 Press the > key.
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Press the A or v key until >Feed Select appears.

>Feed Select
Cassette

Press the ENTER key. A blinking question mark (?) appears.

?Feed Select
nNo

? Cassette
I|\

Press the A or v key to display the desired paper source (no option
paper feeder).

MP Tray
Cassette (Default)
With an option paper feeder added:

MP Tray
Cassette 1 (Default)
Cassette 2

where Cassette 1 isthe printer paper cassette and Cassette 2

the option paper feeder.

When the desired paper source is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.

Overriding A4 and Letter Size Difference

This selects whether to enable or disable the difference between A4 size
and Letter size. Under the default setting of Of £, the paper size of the
paper source is matched to the paper size formatting the jobs. If they differ,
a corresponding error message is displayed. When this is set to On, printing
is performed even if the actual paper size differs from the paper size
formatting the jobs.

1
2

Press the MENU key.

Press the A or v key until Paper Handling > appears.

Paper Handling >
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7
8

Press the > key.

Press the A or v key until >0verride A4/LT appears.

>Override A4/LT
Off

Press the ENTER key. A blinking question mark (?) appears.

?Override A4/LT
2 0ff
I|\

Select On or Of f using the A or v key.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.

Customizing the Paper Type

The following describes the procedure used to set a user-defined paper type
for the printer. Eight custom user settings may be registered. After having
been set, any of them may be called up when setting the paper type for a
paper source.

The paper weight and print density can be set (see Setting the Paper
Weight on page 1-70, and Adjusting the Print Density on page 1-71) after
selecting the paper type to be customized as follows. For how to reset the
customized settings, see Resetting the Type Adjust on page 1-73.

1
2

Press the MENU key.

Press the A or v key until Paper Handling > appears.

Paper Handling >

Press the > key.
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Press the A or v key until >Type Adjust > appears.

>Type Adjust >
Custom 1

Press the ENTER key. A blinking question mark (?) appears.

?Type Adjust >
P

? Custom 1

I|\

Press the A or v key to display the desired paper type. The display
changes as shown below.

Custom 1 (to 8)
Plain
Transparency
Preprinted
Labels

Bond
Recycled
Vellum

Rough
Letterhead
Color
Prepunched
Envelope
Cardstock

If you want to abandon the selection, press the CANCEL key.

When the paper type to be customized is displayed, press the ENTER
key.

Press the > key and proceed to Setting the Paper Weight below.
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Setting the Paper Weight

You can set the paper thickness for your custom paper type to be
customized.

1

Display the custom paper type (see Customizing the Paper Type
above) and press the > key.

>Type Adjust >
Custom 1

Press the A or v key until >>Paper Weight appears.

>>Paper Weight
Normal

Press the ENTER key. A blinking question mark (?) appears.

?>Paper Weight

nNo
? Normal
I|\

Press the A or v key until desired paper thickness appears. The
display changes as shown below. For details of the default setting for
each paper type, see section 5.4 Paper Type on page 5-11.

Normal

Heavy (Thick)
Light (Thin)

If you want to abandon the selection, press the CANCEL key.

When the desired paper thickness is displayed, press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Adjusting the Print Density

One of the five following print density levels can be selected for printing:
01 (light) to 05 (dark). The default is 03.

+ Before adjusting the print density, you must first select the paper
type.

* You can set the print density for each paper type.
1 Press the MENU key.

2 Press the A or v key until Paper Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key until >Type Adjust > appears.

>Type Adjust >
Plain

5 Press the ENTER key. A blinking question mark (?) appears.

>Type Adjust >
Mo

? Plain
/|\

6 Press the A or v key to display the desired paper type. The display
changes as shown below.

Custom 1 (to 8)
Plain
Transparency
Preprinted
Labels

Bond
Recycled
Vellum

Rough
Letterhead
Color
Prepunched
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Envelope
Cardstock

7 When the desired paper type to set the print density is displayed,
press the ENTER key.

8 Press the > key.

9 Press the A or v key until >>Print Density appears.

>>Print Density
03

10 Press the ENTER key. A blinking question mark (?) appears.

?>Print Density
plg
2. 03

1S

1 1 Select the print density from five steps from 01 (light) to 05 (dark)
using the A or v key.

If you want to abandon this procedure, press the CANCEL key.

12 Press the ENTER key.

1 3 Press the MENU key. The message display returns to Ready.
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Resetting the Type Adjust

Resets all the modifications made in the Type Adjust menu. In other
words, all the settings of the Type Adjust menu return to their default
values.

1 Press the MENU key.

2 Press the A or v key until Paper Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key until >Reset Type Adjust appears.

>Reset Type
Adjust

5 Press the ENTER key. A question mark (?) appears.

>Reset Type
Adjust ?

6 Press the ENTER key. The message display shows Processing, then
all the modifications of Type Adjust return to their default values.
The message display returns to Ready.
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Verifying the Total Printed Pages and Resetting the Toner Counter

You can display the total number of pages printed by your printer for
verification when necessary. It is also possible to check this information
from the Status Page. Moreover, for proper maintenance scheduling, it will
be necessary to reset the toner counter using this menu each time a new
toner container is installed.

Verifying the Number of Total Printed Pages

This procedure only displays the total number of printed pages. The
number cannot be changed.

1 Press the MENU key.

2 Press the A or v key until Life Counters > appears.

Life Counters >

3 Press the > key.

4 Press the A or v key until >Total Print appears.

>Total Print
0123456

5 Press the MENU key. The message display returns to Ready.
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Resetting the Remaining Toner Counter

If the toner container was replaced, reset the toner counter as follows so
that an accurate toner gauge measurement is indicated on the status page.
Note that if this operation is performed when the toner cartridge is not
replaced, the toner gauge measurement will not be indicated correctly.

Also refer to the Installation Guide supplied with the toner kit when
replacing the toner container.

1 Press the MENU key.

2 Press the A or v key until Life Counters > appears.

Life Counters >

3 Press the > key.

4 Press the A or v key until >New Toner Installed appears.

>New Toner
Installed

5 Press the ENTER key. A question mark (?) appears.

>New Toner
Installed 7

6 Press the ENTER key. The toner counter is reset, and the message
display returns to Ready.
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Other Modes

The modes described in the following pages can be accessed from the
Others submenu.

The Others submenu allows you to perform the following:

*Selecting in what language messages are displayed
*Setting the Automatic Form Feed time-out
*Setting the Sleep Timer

* Dumping received data

*Resetting the printer

* Protecting resources

*Setting the Auto Continue

* Accessing the service menu (for service personnel)

Selecting a Message Language

You can select the language in which the messages on the display will be
presented.

1
2

Press the MENU key.

Press the A or v key until Others > appears.

Others >

Press the > key.

Press the A or v key until >MSG Language appears. The default
message language is English.

>MSG Language
English
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To change the language, press the ENTER key. A blinking question

mark (?) appears.

>MSG Language

n
ﬁ English

Press the v key. The display cycles through the available selections
in the following order (The A key cycles in the reverse order):

>MSG Language
% Engllsh

l| *

>Langue
N
? Francals

l| *

?Anzeigesprache
NEs
? Deutsch

T ‘+

>Lingua
s ,
? Italiano

Ty

>TIdioma
o R
? Espafiol

1S 3

iIdioma da MSG

o .
? Portugués
LS

If you want to abandon this procedure, press the CANCEL key.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Automatic Form Feed Time-out Setting

When the printer remains idle for some time, it times out and releases the
current interface; it prints whatever data is in its buffer and feeds out the
page. You can adjust the time-out length as follows:

1
2

Press the MENU key.

Press the A or v key until Others > appears.

Others >

Press the > key.

Press the A or v key until >Form Feed Time Out appears.
The default is 30 seconds.

>Form Feed
Time Out 030sec.

Press the ENTER key. A blinking cursor () appears.

>Form Feed
|
Time Out O?O'sec .
LA

Press the A or v key to increase or decrease the value where the
cursor is blinking and so set the desired time. The time can be set
between 0 and 495 seconds, in 5-second increments. You can use the
> and < keys to move the cursor right and left.

If you want to abandon this procedure, press the CANCEL key.

Display the desired time and press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Sleep Timer Setting

The printer has a sleep timer that allows to conserve power when it is not
printing, processing or receiving data. You can adjust the timer; in other
words, you can set the length of time before the printer enters sleep mode
when it is idle. The default is 5 minutes.

1 Press the MENU key.

2 Press the A or v key until Others > appears.

Others >

3 Press the > key.

4 Press the A or v key until >Sleep Timer > appears. The default
setting is 005 min.

>Sleep Timer >
005 min.

5 Press the ENTER key. A blinking cursor (_) appears.

>Sleep Timer

1
065' min.
Ll

6 Press the A or v key to increase or decrease the value where the
cursor is blinking and set the desired time. The timer can be set
between 5 and 240 min., in 5-minute increments. You can use the >
and < keys to move the cursor right and left.

If you want to abandon this procedure, press the CANCEL key.
7 Press the ENTER key.

8 Press the MENU key. The message display returns to Ready.
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Turning Off the Sleep Timer

You can turn off the sleep timer function by following the procedure given
below.

1 Press the MENU key.

2 Press the A or v key until Others > appears.

Others >

3 Press the > key.

4 Press the A or v key until >Sleep Timer > appears.

>Sleep Timer >
005 min.

5 Press the > key and display >>Sleep Mode.

>>Sleep Mode
On

6 Press the ENTER key. A blinking question mark (?) appears.

>>Sleep Mode
ao

? On

/|\

7 Select Of f using the A or v key.

>>Sleep Mode
" off
1S

If you want to abandon this procedure, press the CANCEL key.

8 Press the ENTER key.

9 Press the MENU key. The message display returns to Ready.
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Received Data Dumping

To debug programs and files, you can print data as hexadecimal code as
shown below.

1
2

Press the MENU key.

Press the A or v key until Others > appears.

Others >

Press the > key.

Press the A or v key until > Print HEX-DUMP appears.

>Print HEX-DUMP

Press the ENTER key. A question mark (?) appears.

>Print HEX-DUMP?

Press the ENTER key again. Processing appears for a second, and
then Waiting appears.

Processing

) 4

Waiting

Send data to be dumped to the printer. The message Processing is
displayed while it is receiving the data.

Once the dumped data you require has been output, it is possible to
cancel the printing of any further dumped data by taking the printer
offline. Do so by pressing the GO key and then the CANCEL key.

Once all data has been received, the message Waiting appears.
Press the GO key to finish printing.
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Resetting the Printer

This procedure describes how to reset the printer. This operation is equal to
turning the power ON and OFF. It erases downloaded fonts and macros.

1 Press the MENU key.

2 Press the A or v key until Others > appears.

Others >

3 Press the > key.

4 Press the A or v key until >Printer Reset appears.

>Printer Reset

5 Press the ENTER key. A question mark (?) appears.

>Printer Reset °?

If you want to abandon this procedure, press the CANCEL key.

6 Press the ENTER key again. Self test appears while the printer is
resetting itself, then Please wait followed by Ready.

Self test

) 4

Please wait

) 4

Ready
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Protecting Resources

When you switch from the PCL 6 emulation to another, all downloaded
fonts and macros are lost. Resource protection preserves these PCL
resources in memory so that they are intact when you change the
emulation back to PCL 6.

Resource protection requires extra memory to store downloaded fonts
and macros. The total size of the printer memory recommended for using
the resource protection function is affected by several factors.

1 Press the MENU key.

2 Press the A or v key until Others > appears.

Others >

3 Press the > key.

4 Press the A or v key until >Resouce Prot. appears.

>Resouce Prot.
Off

5 Press the ENTER key. A blinking question mark (?) appears.

?Resouce Prot.

pN

? 0ff
71

6 Press the A or v key to display the desired mode. The display
changes as shown below.

Of f (default)

Permanent
Perm / Temp

If you want to abondon this procedure, press the CANCEL key.

7 When the desired mode is displayed, press the ENTER key.

8 Press the MENU key. The message display returns to Ready.
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Auto Continue Setting

If an error that still allows you to continue printing occurs (Memory
overflow Press GO, Print overrun Press GO, KPDL error Press
GO, File not found Press GO,MemoryCard err Press GO and RAM
disk error Press GO), the next received data is automatically printed
after a set period of time elapses. For example, if the printer is shared over
a network as a network printer and one person causes one of the above
errors, after the set period of time elapses, the data sent from the next
person is printed. The default is Of £.

1
2

Press the MENU key.

Press the A or v key until Others > appears.

Others >

Press the > key.

Press the A or v key until >Auto Continue Mode> appears.

>Auto Continue >
Mode Ooff

Press the ENTER key. A blinking question mark (?) appears.

>Auto ?ontinue >
Mode 27 Off
21N

Select On or Of f using the A or v key.

If you want to abandon this procedure, press the CANCEL key.

Press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Setting the Auto Continue Recovery Time

Follow the procedure given below to change the recovery time for Auto
Continue.

1
2

Press the MENU key.

Press the A or v key until Others > appears.

Others >

Press the > key.

Press the A or v key until >Auto Continue > appears.

>Auto Continue >
Mode On

Press the > key and display >>Auto Continue Timer.

Press the ENTER key. A blinking cursor (_) appears.

>>Auto Continue

1
Timer O?O%ec.
Ll

Press the A or v key to increase or decrease the value of the figure
where the cursor is blinking and set the desired time. The time must
be set between 000 and 495 seconds, in 5-second increments. If set to
000 , printing will be continued immediately without allowing any
time interval. You can use the > and < keys to move the cursor right
and left.

If you want to abandon the selection, press the CANCEL key.

Display the desired time and press the ENTER key.

Press the MENU key. The message display returns to Ready.
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Service Menu

The service menu contains maintenance operations to be performed by
service personnel. The Print Status Page and Developer submenus
appear. However, in general, you will only need to use the Print Status
Page submenu.

Printing a Service Status Page

The service status page contains printer setting informations more
detailed than those of the standard Status Page and is therefore mostly for
service purposes. However, since there is a great deal of information
available on the service status page, it might be helpful.

1 Press the MENU key.

2 Press the A or v key until Others > appears.

Others >

3 Press the > key.

4 Press the A or v key until >Service > appears.

>Service >

5 Press the > key.

6 Press the A or v key until >>Print Status Page appears.

>>Print
Status Page

7 Press the ENTER key. A question mark (?) appears.

>>Print
Status Page ?

8 Press the ENTER key. The message display indicates Processing
and printing starts. After the service status page is printed, the
message display returns to Ready.
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Chapter2  Using the Printer
Software

This chapter provides basic information that let you learn how to setup the
printer and how to install the printer driver. Further detailed information
about the installation can be obtained from the printer driver’s online help.
To read the online help, click the Help button on a dialog box displayed by the
printer driver.

the printer driver may vary depending on the version of the print driver. The

g For improvement purpose, the user interface design and functionalities of
Note diagrams used throughout this chapter are only for examples.

This chapter explains the following topics:

* Installing the Printer Driver

* Using USB Interface

» Setting Up the Default Properties

* Printing from Windows Applications
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Installing the Printer Driver

2.1 Installing the Printer Driver

i

Note

If you want to use the printer as a USB printer, you should install the USB
device driver first. See section 2.1.2 Using USB Interface on page 2-9 for
instruction.

2.1.1 Using Parallel/Serial Interfaces

iy

When you insert the Kyocera Mita Digital Library CD-ROM supplied with
the printer into your computer, the setup screen is automatically displayed.
To install the printer driver, follow the on-screen instructions.

1 Set the Kyocera Mita Digital Library CD-ROM in your computer’s
CD-ROM drive.

After a few moments, the License Agreement window opens.

If this screen does not appear, click the Windows Start button and select
Run. Type the following in the Command Line text box:
[CD drive letter]:\setup

Click the OK button. After a few moments, the License Agreement
window appears.

2 Click View License Agreement. The License Agreement PDF
opens. Read the terms and conditions.

i Kyocera Mita Digital Library

el
D',gialfy

By using or installing the device drivers
and Software included on this CD-ROM,
you agree to become bound by the terms
and conditions of this License Agreement.
Please open and read.

License Agreement

(View License Agreement)
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If you do not have Adobe Acrobat Reader installed on your computer,
the following dialog box will open. Click the Yes button and install it.

Install Acrobat Reader ]

Thiz PDF format file requires Adobe Acrobat Reader.
‘wiould you like ta install it now?

Close the License Agreement PDF. On the previous License
Agreement window, click Accept to accept the agreement. After a
few moments, the Main Menu appears.

Click Install Drivers. The Kyocera Mita Setup Wizard begins. Click
the Next button.

i Kyocera Mita Digital Library

Main Menu

=tall L
Driver Tools
Printer Utilities
Networking
Documentation
Select Language

Install Kyocera Mita printer drivers for Windowws 95, 98, ME, NT 4.0 5

In the Select a device model window, click FS-1050.

Setup x|
Select a device mode

If your model is not listed, click on the Classic Models button for
additional selections.

Available models:

Model description:

14-FPM Perzonal lazer printer

Clazzic Models | < Back I Mest » I Exit

Click the Next button.




Installing the Printer Driver

6 In the Select a driver language window, click the language you want.

Click the Next button.

7 Kyocera Mita FS-1050 KX is highlighted in the Available drivers list
box.

Click the Next button.
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In this window, you can choose whether you want to install TrueType
screen fonts and/or Prologue/Epilogue tab. Click the appropriate
option(s).

Setup x|
Select driver options

Select from the list below the options that you want ta ingtall with
thiz driver. Multiple options may be selected.

Awailable options:

up | fo
[ Prologue/E pilogue Module

- Thiz option will inztall TrueT ype screen fonts that match the
-, resident printer fonts. This will insure that the fonts displayed on
the screen and the fonts on the printed page will look the zame.

< Back I Mest » I Exit

Click the Next button.

In the Device connection window, select the type of connection
between the printer and your computer.

If you want to connect to a network, contact your network
administrator.

Setup x|
Device connection

Select the type of connection between the device and your
computer. Once selected, click Mext.

The device is connected directly to a serial
or parallel port on the computer.

The device is connected through a network,
interface card. The device alzo may be
attached to another computer on the
hetwork.

< Back I Mest » I Exit

Click the Next button.
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1 In the Select a device port window, select the interface you want to
use for connecting to the printer.

Click the Next button.

1 In the Select a device name window, enter a unique name for the
printer, if desired.

Click the Next button.

12 If you want to use the printer as the default printer, click the Yes
button.
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13 In the Begin installation window, click the Next button.
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Confirming the Installation

After you restart the printer, follow the instructions below to make sure if
the printer driver has been installed correctly.

1 Click the Windows Start button, point Setting, and click Printers to
make sure the Kyocera Mita FS-1050 KX icon has been added to the
Printers window.

B3 Printers M[=]E3
J File Edit “iew Go Favorites Help |
b P 3
@ . > G| ¥ ) ‘
Back Eanyard Up Cut Copy Paste Undo
JAgdress I Frinters j

= Add Printer
Printers

-

This folder
contains
information about -
your current
printers and a
wizard to help
you install new
ones,

| H

B

2 Right click the Kyocera Mita FS-1050 KX icon and select Properties.
The following dialog will open. Click the Details tab to make sure the
port you have selected in step 11 on page 2-6is shown in the Print to
the following port list.

Kyocera Mita F5-1050 KX Properties EE3

Device Settings I About I
I Media I Lapout I

Prologue/E pilogue I Clutput I

General Dietails Color kM anagement I Sharing Imaging

Kyocera Mita FS-1050 kx

Frint to the following port:

JLPT1: {Printer Port

Frint uzing the following driver:

j Add Part... |
Delete Port... |

|Kyacera Mita FS-1050 Kx

j Mews Diriver... |

LCapture Printer Part... | End Capture... |

|1 5 seconds
Tranzmizzion retry: |45 zeconds

Spool Settings... |

Timeout zetting:

Mot zelected:

Fart Settings... |

o]

Cancel | Lol | Helg |

Click the OK button to close the window. Proceed to section section
2.2 Setting Up the Default Properties on page 2-16to make default
settings.
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2.1.2 Using USB Interface

You can print to the printer’s USB connector if Windows 98/Me or Windows
2000 is running on your computer. You need to connect the printer to your
computer using a USB cable and install the USB Printing Support onto the
computer which is supplied by the Kyocera Mita Digital Library CD-ROM.

Installing the USB Printing Support

This section explains you how to install the USB Printing Support as well
as the printer driver onto your Windows 98 computer. If you are using
Windows Me or 2000, you can use the similar proccedure. Follow the
instructions displayed on the screen.

1 Turn on the computer and the printer, then insert the Kyocera Mita
Digital Library CD-ROM into the computer’s CD-ROM drive

2 Connect the printer and the computer using a USB cable.

3 The Windows Plug and Play function will detect the printer
automatically and the Add New Hardware Wizard will open.

Add New Hardware Wizard

This wizard searches for new drivers for:

USE PFrinting Support

A device driver iz a software program that makes a
hardware device work.

Cancel

Click the Next button.
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4 Select Search for the best driver for your device.

Add New Hardware Wizard

‘what do you want ‘Windows to do?

& Search for the best driver for pour device.
{Recommended].

" Display a list of all the drivers in a specific
location, so you can select the driver you want.

< Back I Mext » I Cancel

Click the Next button.

5 Select Specify a location. In the box below, enter
[CD-ROM drive letter]:\usb.

Add New Hardware Wizard

“windows will search for new drivers in its driver database
on vour hard drive, and in any of the fallowing selected
locations. Click Mest to start the search.

[~ CD-ROM diive

™ Microsoft Windows Update

V' Specify a location:
|o-wsE =l
Browse... |

< Back I Mext » I Cancel |

Click the Next button.
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The Wizard will search the directory. The following dialog box will open
when the necessary file has been found. Make sure [CD-ROM drive
letter ]:\\USB\USBPRINT.INF is shown on the dialog box.

Update Device Driver Wizard
“Windows driver file search for the device:

USE PFrinting Support

Windows iz now ready to install the best driver for thiz
device. Click Back to select a different driver. or click Mext
ta continue.

Location of driver:

w D:AUSBAUSBRRIMT.IMNF

Cancel |

Click the Next button. The installation of the USB Printing Support
will start.

The following dialog box will open when the installation has been
completed. The above completes installing the USB Printing
Support. Proceed to the next section.

Add New Hardware Wizard

% USE PFrinting Support

Windows has finizhed installing the software that your new
hardware device requires.

< Back Cancel

Click the Finish button.




Installing the Printer Driver

Installing the Printer Driver for USB

1 Subsequently the installation of the printer driver will begin. Click
the Next button on the dialog box below.

Add New Hardware Wizard

This wizard searches for new drivers for:

KyoceraFS-1050

A device driver iz a software program that makes a
hardware device work.

Cancel

2 Select Search for the best driver for your device.

Add New Hardware Wizard

‘what do you want ‘Windows to do?

& Search for the best driver for pour device.
{Recommended].

" Display a list of all the drivers in a specific
location, so you can select the driver you want.

< Back I Mext » I Cancel

Click the Next button.




Installing the Printer Driver

Click the Specify a location check box, then enter
[CD-ROM drive letter]:\Drivers\Multi
in the box below.

Add New Hardware Wizard

“windows will search for new drivers in its driver database
on vour hard drive, and in any of the fallowing selected
locations. Click Mest to start the search.

™ Floppy disk drives
I~ CD-ROM drive
™ Microsoft Windows Update

V' Specify a location:
|D:\Drivers\bult =l

Browse... |
< Back I Mext » I Cancel |

Click the Next button.

Click the Next button on the dialog box below.

Add New Hardware Wizard

“Windows driver file search for the device:

Kyocera Mita FS-1050 kx

Windows iz now ready to install the best driver for thiz
device. Click Back to select a different driver. or click Mext
ta continue.

Location of driver:

w DADRIVERSAMULTISOEMSETUR.INF

< Back Cancel
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5 Add Printer Wizard will open. Follow the instructions shown on the
wizard and complete the installation of the printer driver.

Add New Hardware Wizard

“Windows driver file search for the device:
Add Printer Wizard
*Y'ou can type a name for thiz printer, or you can use

the name supplied below. *When you have finished,
click Mext.

FErinter name:

Do you want your Windows-based programs to use this
printer as the default printer?

 Yes
& No

< Back | Mext » | Cancel |

6 Click the Windows Start button, point Setting, and click Printers to

make sure the Kyocera Mita FS-1050 KX icon has been added to the
Printers window.

B3 Printers M[=]E3

J File Edit “iew Go Favorites Help |
@ . > G| ¥ ) i
Back Eoryard Up Cut Copy Paste Unda

JAgdress I PFrinters j
= Add Printer

Printers i£5:1050

This folder

contains

information about
your current
printers and a
wizard to help
you install new
ones,

|

SULER




Installing the Printer Driver

Right click the Kyocera Mita FS-1050 KX icon and select Properties.
The following dialog will open. Click the Details tab to make sure USB
001 (Virtual printer port for USB) is selected for the Print to the
following port list.

Kyocera Mita F5-1050 KX Properties

| e R,

e
&

USBO0T [Wirtual printer port for LISE) I

Kyocera Mita FS-1050 kx I

|
_
_SoodiSeltngs. | _Pa Setigs.._|

Click the OK button to close the window. Proceed to the next section.
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2.2 Setting Up the Default Properties

This section explains how to set the option paper feeder and printer
description language using the Device Settings tab on the Properties
dialog box.

For more information about setting the printer, refer to the printer driver’s
online help.

effective for all application software. To temporarily change the settings,
Note select File - Print - Properties from a Windows application. See section
2.3 Printing from Windows Applications on page 2-19.

0 The default settings configured using the Properties dialog box will be

2.2.1 Using the Option Paper Feeder

To configure the printer default properties, you should access the printer
Properties dialog box as follows.

1 Click the Windows Start button, point to Settings, and then click
Printers.

2 Right click the Kyocera Mita FS-1050 KX icon, and click Properties.
The Properties dialog box will open. Click the Device Settings tab.

3 In the Device Options list, the Paper Feeder (cassette 1) [printer’s
cassette] is selected by default. If you have installed the option paper
feeder, check the Paper Feeder (cassette 2).

Kyocera Mita F5-1050 KX Properties EE3
General I Dretailz I Color kM anagement I Sharing | Media | Layout I Imaging I
Prologue/E pilogue I Output Device Settings | About

Device Dptions:
—

[ Paper Feeder [Cassette
% Paper Feeder [C
CJRAM Disk

1

User.. | Memary: I'IB ME i’
Adminigtrator... | sk Dyek: I? MBE i’

QK I Cancel Lol Help
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Setting Up the Default Properties

Page description language (PDL) instructs the printer how to handle print
data for printing. Depending on the page description language used for the
document to print, you can select from PCL XL, PCL 5e, and KPDL
(Kyocera’s implementation of the PostScript language).

A page description language is referred to as an ‘emulation’ in the menu
system of the operator panel in Chapter 1.

To configure the printer default properties, you should access the printer
Properties dialog box as follows.

1 Click the Windows Start button, point to Settings, and then click

Printers.

2 Right click the Kyocera Mita FS-1050 KX icon, and click Properties.
The Properties dialog box will open. Click the Device Settings tab.

3 Click the User button. The User Settings dialog box opens.

Kyocera Mita F5-1050 KX Properties

Generdl | Detals | ColorManagement | Shaing | Media | Lepout | Imaging |
Fiologue/Epiogue

Output

Device Settings

About

Acministrator... e Eis
User Settings EE
:gm ~Identification
. Wk
Corcd | Depatment I
- Page Description Languag
PCL %L ~| I GDI compatible made
Setlings..
Ui
’Vr‘ Inches & Millmeters




Setting Up the Default Properties

4 In the Page Description Language drop down list, select the
appropriate one. The available options are: PCL XL, PCL 5e, and
KPDL.

User Settings EE3

~ Identification

User Mame: I

Department: I

— Page Description Language

[T GDI compatible mode

Settings... |

7 Inches & Millmeters

Ok I Lancel |

Click the OK button to close the window.
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2.3 Printing from Windows Applications

This section will discuss how to print from Windows applications using a
Microsoft Word document as an example.

2.3.1 Basic Printing Task

This section will explain only the minimum task that is required to print
from Windows applications. You can select various options in the printer’s
Properties dialog box to customize your print job as explained in section
2.83.2 Setting Custom Paper Size on page 2-21 and later.

1 Set the paper of the size specified in the application for the document
into the printer’s paper cassette. For details on how to set paper,
refer to the Installation Guide.

Using the operator panel, make sure if each paper source has paper of
the proper size. If not, set the appropriate paper into the source (see
Setting the Cassette Size on page 1-62). If they have different paper, the
output may not be printed correctly.

2 Open the document you want to print. The following example shows
how to print a Word document.

3 Select Print from the File menu of Word. The Print dialog box will appear.

Print 2] ]

rPrinter
(oo )7

: . Kyocera Mita FS-1050 Kt

Mame: H
Idle

Status: 4
Type: Kyocera Mika F5-1050 KX
Where: LPTL: I™ Prirt ta file
Comment:
Page range HCopie:
(05 all (Number of copies: I 1 ﬁ)-—— 6
5 " Current page £ Selection
L("' Pages: I 11 11 v Collate
& &
Enter page numbers andjor page ranges
separated by commas, For example, 1,3,5-12

Zoom

Print what: IDocument j Pages per sheet: |1 page vl
Pint: [0 pages in range x| | scale to paper size: |No Scaling vl
Options. .. | OF I Close |

4 From the Name drop down list, select Kyocera Mita FS-1050 KX
printer if it is not selected.

5 Enter the page range of the document you want to print. To print the

whole document, select All.

6 Enter the number of copies, 1 to 999, you want to print in the
Number of Copies combo box.
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7 Click the Properties button. The Properties dialog box opens.

8 On the Media tab, select the paper size that matches the paper size
of the document from the Page Size drop down list. The printer will
automatically switch to the paper source (the paper cassette, MP
tray, or the option paper feeder, if installed) so that the correct paper
will be used.

Kyocera Mita F5-1050 KX Properties EE3
Media | Lapout I Imaging I Frologue/E pilogue I Clutput I About I
FPage Size: Ad - 210 % 257 mm
~])_ cwon. |
Frint Size: Ad-210 % 257 mm
ISame az Page Size j
Orientation:
& Potrait
™ Rotated
' Landscape
Source: IAuto Source Selection j
Media Type: IAuto Media Selection j
Settings... | Frestarne [Mefaults |

QK I Cancel | Help |

Click the OK button to close the Properties dialog box and return to
the Print dialog box.

10 Click the OK button to start printing.
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2.3.2 Setting Custom Paper Size

This printer can feed non-standard size of paper. The paper cassette can
accommodate paper whose sizes are ranging from 148 to 216 mm in width
and 210 to 297 mm in length as well as Legal size. Note the MP tray can
accommodate paper whose sizes are ranging from 70 to 216 mm in width
and 148 to 297 mm in length.

To set the custom size

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Custom button on the Media tab. The Custom Paper Sizes
dialog box appears.

Custom Paper Sizes EE3

Customized Paper Sizes

Eemoye |
Eddif... |

Ok | Lancel |

3 Click the Add button. The Edit Paper Size dialog box appears.

Custom Paper Sizes EE3

Customized Paper Sizes

Add button
Eemoye |
Edt |
Edit Paper Size EE3
—Mame
fl Name settings
(Size
g ) [ = .
—— | Height  [27a4 jwu:lth [2153 = Paper Size
ke I Lancel |

4 Enter a descriptive name for the custom size in Name.
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Note

5 Enter the height and width of the custom size in Size.

Edit Paper Size EE3

—Mame

Ukyoc:era-mitaﬂ‘l

(Gize

Height |280.5 % Width |215.9 ﬂ
K I

Lancel |

You can select the unit of measurement; inches or millimeters, on the

User Settings dialog box to be accessed by clicking the User button on
the Device Settings tab.

Click the OK button. The custom paper size is added to the
Customized Paper Sizes list.

7 Click the OK button. The Media tab is displayed again.

8 Select the Custom Size from the Page Size drop down list.

Kyocera Mita F5-1050 KX Properties

7] %]
Media | Layout I Imaging I Prologue/E pilogue I Output I About I
FPage Size: kyocera-mitall - 215.9 % 2805 mm
kyocera-mitall ﬂ Custom...
Envelope #10 -
Envelope #3 |59 = 2805 mm
Envelope Monarch
Envelope H#E
Envelope C5
& Portrait
™ Rotated
' Landscape
Source: IAuto Source Selection j
Media Type: IAuto Media Selection j
:g KYOCERA Settings... | Restore Defaults |
pe——
QK I Cancel | Help |

9 Click the OK button again to return to the Print dialog box.

10 Click the OK button to start printing.
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2.3.3 Advanced Media Settings

Note

Making the Advanced Media settings allows you to activate the following
advanced printer functions.

+ Cover mode: Adds the front cover and/or the back cover to the
document.

* Page insert: Inserts a blank or printed page before any page(s) of the
document.

+ Transparency interleaving: Inserts a blank or printed page between the
transparencies to be printed.

These functions are explained on the following pages.

Cover Mode

In the Cover mode, the first cover page, or the first and back cover pages of
a document will be added to the document using the different paper from
the paper used for the body of the document. The rest of the document will
be printed on the paper specified in the Media tab. This will allow you to
add the covers of the document using special paper, for example thick
paper or colored paper, so that the printed document looks more
professional.

You can also print the first page of the document on the front cover by
checking Print Outside Cover.

Cover Mode can be used with Page Insert but not with Transparency
Interleaving.
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To print the cover pages on the different paper

1
2

application software.

Settings dialog box opens.

Kyocera Mita F5-1050 KX Properties HE
Media | Layeut | Imaging | Prologue/Epiague | Output | About |
Page Size: £4-210% 257 m
R - Custom.
it Size: £4-210% 257 m

Same as Page Size =

™ Botated

Auto Source Selection =
Auto Media Selection =

Orientatior
& ottt
€ Landscaps
Source:
Media Type:

Display the printer driver’s Properties dialog box from the

Click the Settings button on the Media tab. The Advanced Media

B Advanced Media Settings
03} KYOCERD @Mws_ T Cover bode
— ) ot I~ Fiirt Dutside Caver
’E ) Frart end Eack I | Frit rsicle Caver
> St fonleaven Cassette 1 =l
I Page Inzeit
I= | Print anta Frart I~ | Frint onto Bask
It Befor= Pages. |
Sauroefor Pags [Cassetie 1 =
I ranipamency Inteeaving
I= | Fiint crtz Backing
Soirce for BAsking [Cassetie 1 =
Fleset Cancel
3 Click the Cover Mode check box.
Advanced Media Settings EHE
3 V' Cover Mode i
]II & Front ¥ Print Dutside Co 5
I " Front and Back = | Britit I rside Coyer
Source for Cover: (I Multi-Purpose Feeder - 6

I Page Insert

I™ | Britit arite Frornt

I | Britit arite Back

|rmzert Befare Fages I

Saurze fon Fage: IEassette 1

1= | Trarsparency lhterleaying

I | Britit arit Backing

Saurze fon Backing IEassette 1

5

Reset |

Lancel |
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To add only the front cover using different paper, click Front, or to
add both the front and back covers using different paper, click Front
and Back.

To print the first page on the cover, click the Print Outside Cover
check box. Note that the Print Inside Cover is not applicable for
model FS-1050.

Select the paper source for the cover(s) from the Source for Cover
list box. Note that thick paper, colored paper, etc., should be loaded
on the MP tray.

Click the OK button to return to the Print dialog box.

Load the paper you want to use for the cover(s) onto the paper source
specified in step 6.

Click the OK button to start printing.

Page Insert

With Page Insert, the printer inserts a blank or printed page before any
page(s) of the document that you specify. This function will allow you to
insert a page that can be used to clearly separate a chapter, etc., from the
previous chapter.

It is also possible to print the chapter cover page on the separate sheet.

Page Insert can be used with Cover Mode but not with Transparency
Interleaving.
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To include a separator sheet in the document

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Settings button on the Media tab. The Advanced Media
Settings dialog box opens.

Kyacera Mita F5-1050 KX Properties 7]

Media | Layout | Imaging | Frologue/Epigue | Outpet | Abaut |

Page Size: Ad- 210 4 297 mm
R ~ Custom
i Gize: £d - 210 4 237 mm

Same as Page Size -

Orientatior
 Portralt
I™ Rotated
£ Landscape

Source; At Source Selection B
Media Type: uito Media Selection hd

Advanced Media Settings

!gK‘.'I:I 3 T Cover Mode
Setlings L
meffa -

m— ) ot I~ Fiirt Dutside Caver

) it e Bck I=| Frinit sidle Cover

St fonleaven Cassette 1 =l

=
o

I Page Inzeit

I= | Print anta Frart I~ | Frint onto Bask

It Befor= Pages. |

Sauroefor Pags [Cassetie 1 =

I Hanspaiency Intarlsawing

I= | Fiint crtz Backing

Souree for Backing [Cassetie 1 =

Fleset Cancel

3 Click the Page Insert check box.

Advanced Media Settings EE3

I Cover Mode

) Erotit = | Brinit Wutside Eaoyer

) ot and B ack = | Britit I rside Coyer

Soaureifan Eaver: I Cazsette 1 j

3_— V' Page Inzsert

( V| Prirt anto F[Dnt) R 5
Inzert Before Pages 05.1 11318 ) 4
Source for Page: (lMuIti-Purpose Feeder - 6

1= | Trarsparency lhterleaying

I | Britit arit Backing

Saurze fon Backing IEassette 1 j

Fieset | Ok Lancel |

2-26



8
9

Printing from Windows Applications

Enter the page numbers before which you want to insert a page in
the Insert Before Page box. The page number range you can specify
is from 2 to 255. If you want to specify more than one page numbers,
separate them with commas. To specify a range of pages, use a
hyphen between the starting and ending numbers in the range. For
example, to insert separators before pages 5, 11, 12, 13, and 18, type
“5, 11-13, 18.

Select the Print on to Front check box to print on the separators.
Note that the Print onto Back is not applicable for model FS-1050.

If you check this check box on, each separator sheet is printed with
data reflecting its position in the entire print job. For example, the
separator between pages 9 and 10 will be printed as page 10 when
you select this check box.

Select the paper source for the separators from the Source for Page
drop down list. Note that thick paper, colored paper, etc., should be
loaded on the MP tray.

Click the OK button to return to the Print dialog box.

Load the paper you want to use for the separator(s) onto the paper
source specified in step 6.

Click the OK button to start printing.

Transparency Interleaving

This function is available when the current media type is Transparency

and the source is MP Tray (see Setting the MP Tray Type on page 1-60). It
inserts a blank (or printed) backing sheet between the transparencies to be
printed. You can print the same content of the transparency on the backing

sheet.

Transparency Interleaving cannot be used with either Cover Mode or
Page Insert.
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To insert sheets between transparencies

1 Display the printer driver’s Properties dialog box from the
application software.

2 Select Multi-Purpose Feeder (MP Tray) from the Source list box and
Transparency from the Media Type list.

Kyocera Mita F5-1050 KX Properties EE3
Media | Lapout I Imaging I Frologue/E pilogue I Clutput I About I
FPage Size: Ad - 210 % 257 mm
|A4 j Custom... |
Frint Size: Ad-210 % 257 mm
ISame az Page Size j
Orientation:
& Potrait
™ Rotated
' Landscape
Source: (I Multi-Purpose Feeder ;D
Media Type: Anzparency
Settings... | Fiestore Defaults |

QK I Cancel | Help |

Click the Settings button on the Media tab. The Advanced Media
Settings dialog box opens.

4 Click the Transparency Interleaving check box.

Advanced Media Settings EE3

== | Eoyverbiode

) Erotit = | Brinit Wutside Eaoyer

) ot and B ack = | Britit I rside Coyer

Soaureifan Eaver: I Cazsette 1 j

I~ | Eage ngert

I™ | Britit arite Frornt I | Britit arite Back
|rmzert Befare Fages I
Saurze fon Fage: IEassette 1 j
4— ¥ Transparency Interleaving
Source for Backing (lEassette 1 ;II“ 5

Fieset | Ok I Lancel |
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Select the source for the backing sheet from the Source for Backing
list box, for example Cassette 1.

Select Print onto Backing if you want the same data to be printed on
the backing sheet as on the transparency.

Click the OK button to return to the Print dialog box.
Load the paper you want to use for the backing(s) onto the paper
source specified in step 8.

Click the OK button to start printing.

2.3.4 Printing Multiple Pages per Sheet

You can print multiple pages on a single sheet of paper, in groups of 1, 2, 4,
6,9, 12, 16, or 25 pages. You can also select the layout of the pages printed
on a sheet.

1
2

Display the printer driver’s Properties dialog box from the
application software.

Click the Layout tab.

Select the number of pages to be printed from the Pages per Sheet
drop down list. You may select 1, 2, 4, 6, 9, 12, 16, or 25 pages. The
graphic on the left will change to reflect your selection. If you want to
add borders to each page printed on the sheet, click Print Borders.

|
Kyocera Mita F5-1050 KX Properties EE3

Media Lavout | Imagingl Prologue.-"EpiIogueI Dutputl About I

Fages per Sheet: ~ || (T Print Borders

Layout: IAuto j

Scaling (20 - B00%): |1 1l1=4 i’ Gutter Settings... |

= | Britit i Bt Sides ([ anua Dusles):
) Fiip ory Lot Edae

" | Frint mstmictions
) Flim oy Shon Edge

Fiestore Defaults |
QK I Cancel | Help |
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4 To select the relative position of each page printed on the sheet,
select an option from the Layout drop down list.

[
Kyocera Mita F5-1050 KX Properties EE3

Media Lavout | Imagingl Prologue.-"EpiIogueI Dutputl About I

Pages per Sheet: |4 'l IV Brirt Borders

Layout:

Bottom to Top and Left

Scaling (20 - 500 | Bottom to Top and Right

eellig ! Left to Right and Down

Left to Right and Up -

. - |Right to Left and Diown
I™ | Fiint o Bth Sid Right to Left and Up -

) Fiip ory Lot Edae

" | Frint mstmictions
) Flim oy Shon Edge

Fiestore Defaults |
QK I Cancel | Help |

5 Click the OK button to return to the Print dialog box.

6 Click the OK button to start printing.
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2.3.5 Changing the Size of the Document

When you choose the Scaling option, both the height and width of the page
will be scaled according to the percentage selected. The range for the
scaling percentage is 20 % to 500 %.

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Layout tab.

3 Select the desired percentage from the Scaling box.

Kyocera Mita F5-1050 KX Properties EE3

Media Lavout | Imagingl Prologue.-"EpiIogueI Dutputl About I

Pages per Sheet: I‘I 'l IV Brirt Borders

Layout: IAuto j

ﬂ) Gutter Settings... |

= | Britit i Bt Sides ([ anua Dusles):
) Fiip ory Lot Edae

(Scaling (20 - 500%)

" | Frint mstmictions
) Flim oy Shon Edge

Fiestore Defaults |
QK I Cancel | Help |

4 Click the OK button to return to the Print dialog box.

5 Click the OK button to start printing.
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2.3.6 Printing on Both Sides of Paper (Manual Duplex)

You can print on both sides of paper by using the paper cassette, or option
paper feeder if installed.

When you choose the Print Instructions check box in the Layout tab, either
of the following instruction sheets will be printed out at the start of the
duplex printing to help you to complete the print job.

Manual Duplex Instructions Manual Duplex Instructions

e L i
Long Edge Binding ' Short Edge Binding I

Internal Cassette or Paper Feeder ‘ Internal Cassette or PF-8

3y ¥ 3 $

Place all printed pages (including this page)
into the same paper tray that they were drawn
from this page Face Up and the arrows
pointing toward the printer.

Place all printed pages (including this page)
into the same paper tray that they were drawn
from this page Face Up and the arrows
pointing toward the printer.

Print Instruction Sheets

Although the Print Instructions check box is selected by default, we
recommend to keep this box on until you get used to the duplex print
operation. The instruction sheet to be printed will vary depending on the
binding options you have selected; Flip on Long Edge or Flip on Short
Edge.

You can use long-edge or short-edge binding combined with either
landscape or portrait printing. Use Orientation options on the Media tab to
select the page orientation as follows.

These are: (1) portrait, long-edge, (2) portrait, short-edge, (3) landscape,
long-edge, and (4) landscape, short-edge. The figure below shows these

binding setups.
@)
(1) 2 Portrait,
Portrait, 3 short-edge
long-edge — binding
binding 3
2 5
@
. Lﬁndscape,
short-edge
(3) 2 . binding
Landscape,
long-edge —=
binding
" 2 s
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To print on both sides of paper

1 Display the printer driver’s Properties dialog box from the
application software.

2 Select either the printer’s paper cassette or option paper feeder, if
installed, from the Source list box.

Kyocera Mita F5-1050 KX Properties EE3

Media |Lay0ut| Imagingl Prologue.-"EpiIogueI Dutputl About I

FPage Size: Ad - 210 % 257 mm
|A4 j Custom... |
Frint Size: Ad-210 % 257 mm
ISame az Page Size j
Orientation:
& Potrait
™ Rotated
' Landscape
Source:
Media Type: IAuto Media Selection j

Settings... | Fiestore Defaults |
QK I Cancel | Help |

3 Click the Layout tab.

4 Select the Print on Both Sides (Manual Duplex) check box.

Kyocera Mita F5-1050 KX Properties EE3

Media Lavout | Imagingl Prologue.-"EpiIogueI Dutputl About I

Pages per Sheet: I‘I 'l = | Eitit Eiarders

&- [Capmut: IAuto j

Scaling (20 - B00%): |1 1l1=4 i’ Gutter Settings...

~

(S

o

(H4OCERd
:g Fiestore Defaults |
QK I Cancel | Help |
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To print the instruction sheet, click the Print Instructions check box.

Click Flip on Long Edge if you want to bind the output on the long edge.
Or, click Flip on Short Edge if you want to bind the output on the short
edge.

To set the width of the gutter, click the Gutter Settings button and enter
the desired value in the Gutter field. The width of the gutter ranges from
5.00 to 25.4 mm or from 0.20 to 1.00 inch.

Gutter Settings EE3
(Guter W =] mm (5000254) )
Ok I Lancel |

Click the OK button to return to the Print dialog box.

Click the OK button to start printing. The following message box will
appear on the screen. Wait until all the even pages are printed and
put the printed paper back into the paper source again before
clicking the OK button.

Manual Duplex Instruction [ =]

Wwait until all even sides are printed.
Then follow the instruction to place paper back inta the cassette again.
Press OK to continue.
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1 0 After all the even pages have been printed, take all the printed pages
including the instruction sheet out from the output tray and tap the
edges of the paper to align the sheets neatly. Set all the sheets
including the instruction sheet back into the same paper source with
the instruction sheet facing up and the arrows on the sheet pointing

toward the printer.

0 Nothing will be printed on the instruction sheet.

§

4

Portrait, Long-edge Binding Portrait, Short-edge Binding
Landscape, Short-edge Binding Landscape, Long-edge Binding

1 1 Click the OK button on the Manual Duplex Instruction message box
shown in step 10 above. All the odd pages will be printed.
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2.3.7 Changing the Resolution

You can set the resolution of the print job. Available options are: High
Quality (Fast 1200 mode), Proof (600 dpi), Draft (300 dpi), and Custom.

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Imaging tab.

Kyocera Mita F5-1050 KX Properties EHE |

Media I Layout  Imaging | Prologue.-"EpiIogueI Dutputl About I

Frint Quality:
High Guality 1]

Grayzcale Adjustment:

{:} Brightness —J— IU_

O Contrazt —— J— ’ ID_

TrueType Fonts:

& Download TrueType fonts as outline
" Download TrueType fonts as bitmap

= Substitute with Device fonts

Eomt Substiution. . | Frestarne [Mefaults |

QK I Cancel | Help |

3 Select the resolution of the print job from the Print Quality drop
down list.
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If you want to set Resolution, Kyocera Image Refinement, and

EcoPrint individually, choose Custom and click the | | button next to
the Print Quality drop down list. Select the options you need in the
Print Quality Settings dialog box.

Kyocera Mita F5-1050 KX Froperties

Media | Layout Imaging | Prologue/Epilogue | Output | About |

H
Grassales Adiustment *
{} EELH Print Quality Settings EHE
D Conlisst g lution
TrusTyps Forts
& Dowrlosd T 500 dpi
© Dowrlosd T S
© Substite £ 300 dpi

Ebri SuBsn

— Kyocera Image Refinement EcoPrint—————————
a & On ?’  0On
0 - & 0ff
Ok I Lancel

Click the OK button to return to the Print dialog box.

Click the OK button to start printing.
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2.3.8 Adjusting Grayscale

You can adjust the appearance of the graphic images of your printed job by

using the options under Grayscale Adjustment. The Grayscale

Adjustment options are useful if the printed graphic images are too light,

too gray, or too dark.

Text is unaffected by the Grayscale Adjustment settings.

1 Display the printer driver’s Properties dialog box from the
application software.

2 Click the Imaging tab.

1
Kyocera Mita F5-1050 KX Properties EE3
Media I Layout  Imaging | Dutputl About I

Frint Quality:

IEustom... 'l

Grayzcale Adjustment:

{:} Brightness =~ ——o— J— ID

- +

(P Contrast B J— IU

TrueType Fonts:

& Download TrueType fonts as outline

" Download TrueType fonts as bitmap

' Substitute with Device fonts

Eomt Substiution. . | Fiestore Defaults |
QK | Cancel | Help |

To control the levels of gray, use the Contrast slider.

Click the OK button to return to the Print dialog box.

Click the OK button to start printing.

O O b~ W
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2.3.9 TrueType Fonts

Printing from Windows Applications

You can specify how TrueType fonts will be sent to the printer. Also you can
substitute a certain font in your document with a specified font. The
selected method will affect the speed at which your print job is produced
and may resolve some font printing issues.

1
2

3

Display the printer driver’s Properties dialog box from the
application software.

Click the Imaging tab.

Kyocera Mita F5-1050 KX Properties

Media I Layout  Imaging | Prologue.-"EpiIogueI Dutputl About I

Frint Quality:

[High Qualiy -1

Grayscale Adiustment:

L% pighness ——— f——— 1
(D) Contrast U — + [0

el ype Fonts: ]

& Download TrueType fonts as outline

" Download TrueType fonts as bitmap J

' Substitute with Device fonts

l Eomt Substiution. . |'

pe—— |

Frestarne [Mefaults |

QK I Cancel | Help

Y

To specify how TrueType fonts are sent to the printer, select one of

the options from TrueType Fonts:

* Select Download TrueType fonts as outline to reduce the file size
for printing a large document, especially if it contains several

fonts or several font sizes. This is the default setting.

* Select Download TrueType fonts as bitmap for a print job with
fewer fonts and similar font sizes, though file size will be larger.

* Select Substitute with Device fonts if the print job contains a
font that the printer does not support or if you want to change a
font that is found throughout a large document. This selection

substitutes the old font with the desired font.
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4 If you want to substitute a font with a specified font, click Substitute
with Device fonts, click the Font Substitution button to open the
Font Substitution dialog box. In the System Fonts box, select the
font in your document. In the Available Device Fonts box, select the
font to substitute. Click the OK button to go back to the Properties
dialog box.

Kyocera Mita F5-1050 KX Properties EE3
Media I Layout  Imaging | Prologue.-"EpiIogueI Dutputl About I

Frint Quality:

IHigh Guality 'l J

Grayzcale Adjustment:

{:} Brightness —J— IU_

O Contrazt —— J— ’ ID_

TrueType Fonts:

" Download TrueType fonts as outline

" Download TrueType fonts as bitmap

@: Suybshityte vath Device fonts

:gmm ‘ FEont Substitution. .. I' Fiestore Defaults |
QK I Cancel | Help |

5 Click the OK button to return to the Print dialog box.

6 Click the OK button to start printing.

2-40



Chapter3 Maintenance

This chapter explains how to replace the toner container and how to clean
parts such as the registration roller and charger wire.

This chapter explains the following topics:

* Toner Container Replacement
* Cleaning
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3.1 Toner Container Replacement

When the printer runs low on toner, the message display shows Toner low
TK-17. Be sure to prepare a new toner kit when this message appears. If
printing is continued in this condition, the printer will display the message
Replace toner TK-17 and stop when there is no more toner. Replace the
toner container and clean the inside of the printer.

3.1.1 Toner Container Replacement Interval

Assuming an average toner coverage of 5%, with EcoPrint mode turned off
the toner container will need replacing approximately once every 6,000*
printed pages.

* In the case of a new printer in which a toner kit has been installed for

the first time, the number of copies that can be printed will be
approximately 3,000.

Toner Kit to be Used

Name: TK-17

Description: Toner container
Wiper cloth
Plastic bag

Installation Guide
(The kit supplied with the printer only contains the toner
container and wiper cloth.)

0 * Be sure to distance items such as floppy disks during toner container

Note

replacement.

* Be sure to clean the inside of the printer when replacing the toner
container. For details, see section 3.2 Cleaning on page 3-6.

» Use of original Kyocera Mita toner kits is highly recommended to
prevent printer trouble and ensure the long life of the printer.
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3.1.2 Replenishing Toner

1 Open the printer’s top cover.

2 Pull lock lever #1 to the release (UNLOCK) position, then pull lock
lever #2 to the release (right) position.

Lock Lever #2
Lock Lever #1

3 Gently remove the old toner container. Put it in the supplied plastic
bag and dispose of it.

Plastic Bag
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Toner Container Replacement

Take the new toner container from the bag. Hold it with the
protective seal (orange-colored) facing up. Shake the toner container
horizontally at least 5 times. This ensures that the toner is evenly
distributed inside.

Protective Seal

Install the new toner container in the printer. Push firmly on the top
of the container at the positions marked PUSH HERE until you hear
it click in place.
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Toner Container Replacement

7 While pushing down on the toner container, push lock lever #1 to the
lock (LOCK) position. (Lock lever #2 is automatically locked.)

Lock Lever #1
|

After the toner container replacement is finished, reset the toner counter.
See Resetting the Remaining Toner Counter on page 1-75.

Note
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3.2 Cleaning

To avoid print quality problems, the interior of the printer must be cleaned
with every toner container replacement.

Cleaning should be done from time to time to avoid print quality
problems.

Note

Printer Interior

To avoid print quality problems due to paper dust and debris, clean the
interior of the printer in the following manner.

1 Open the printer’s top and front covers.

Top Cover

2 Lift the process unit together with the toner container out of the
printer.

The drum in the process unit is sensitive to light. Never expose the drum
even to normal office lighting (500 lux) for more than five minutes.

Process Unit
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0 Never stand the process unit on end.

Note

3 Use the supplied wiper cloth to clean dust and dirt away from the
registration roller (metal).

Transfer Roller

Registration Roller

0 While cleaning, be careful to avoid touching the transfer roller (the black
roller).

4 Slide the charger cleaner knob (green-colored) back and forth 2 to 3

times, then return it to its CLEANER HOME POSITION § .

Charger Cleaner Knob

After cleaning, make sure you restore the charger cleaner to its home
position.
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CLEANER HOME POSITION 4 ), a black band will print along the length

0 If the charger cleaner knob is not restored to its home position (marked

5

7

of the page the next time you use the printer.

After cleaning is done, put the process unit back in the printer. To do
so, carefully align the guides at both ends of the process unit with
the slots in the printer.

Process Unit

Front Cover

Close the top cover by pressing down on the front left and right
corners of the top cover.

Top Cover

3-8



Chapter4  Troubleshooting

This chapter explains how to handle printer problems that may occur. If a
problem cannot be corrected, contact your Kyocera Mita dealer.

This chapter explains the following topics:

* General Guide

* Print Quality Problems

* Indicators and Messages
* Correcting a Paper Jam
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General Guide

General Guide

A lot of problems you might encounter with this printer you can deal with
yourself. This section explains how to correct these problems. Therefore, if
some kind of problem occurs, check the following before concluding your

printer is broken.

Symptom Check Items Corrective Measure
The printer does not | Check the READY Off Look through the items below and check
print from the indicator. anything that seems appropriate.
computer. Flashing An error has occurred. For details on error
warnings and remedies, see section 4.3.1
Indicators on page 4-6.
Lit See the appropriate item below.
Check the ATTENTION Flashing See section 4.8.1 Indicatorson page 4-6.
indicator. Lit
A maintenance message appears in the See section 4.3.2 Maintenance Messages on
message display. page 4-7.
Poor print quality. See section 4.2 Print Quality Problemson

page 4-3.

Powerison, thefanis
silent, but nothing

Check that the power cord is properly
connected to the power outlet.

Turn the printer off, plug in the power cord
securely and turn the printer back on.

computer is not
printed normally.

“ghti ontheoperator |y qck that the power switch is in the ON (| ) position.

panel.

The printer produces | Check the interface cable. Connect both ends of the interface cable
status pages, but securely. Try replacing the printer cable. For
data from the details on the parallel interface and USB

interface for this printer, see Appendix C.

Check program files and application
software.

Try printing another file or using another
print command. If the problem occurs only
with a specific file or application, check the
printer settings for that application.

If the problem persists after checking and applying the corrective
measures above, please contact your Kyocera Mita dealer.
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4.2 Print Quality Problems

The following table contains various possible corrective measures for print

quality problems, such

as streaks. The troubleshooting procedure for each

type of problem is outlined below. If the problem(s) persist, contact your

Kyocera Mita dealer.

Printed Results

Corrective Measures

All-black printout

Contact your Kyocera Mita dealer.

Dropouts, horizontal streaks, stray dots

ABC | ABC
123 12

ABC
123

-

Clean the charger wire.

Open the top and front covers of the printer. Remove the
process unit form the printer and slide the charger
cleaner knob back and forth a few times. See section 3.2
Cleaningon page 3-6.

Black or white vertical streaks

ABC | | ABC

Check the operator panel.

Ifthe Toner low TK-17 message appears and the
ATTENTION indicator flashes, install a new toner kit. See
section 3.1 Toner Container Replacement on page 3-2.

123 123

Clean the charger wire.

Open the top and front covers of the printer. Remove the
process unit form the printer and slide the charger
cleaner knob back and forth a few times. See section 3.2
Cleaningon page 3-6.

Check the position of the charger cleaner knob

Open the printer top and front covers. Remove the process
unit from the printer. Make sure that the charger cleaner
knob is restored to its home position. See section 3.2
Cleaningon page 3-6.

(Continued on next page)
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Printed Results

Corrective Measures

Faint or blurred printing

ABC
123

ABC
123

ABC
123

Check the EcoPrint setting.
If EcoPrint is On, switch it Off from the operator panel.
(See EcoPrinton page 1-46)

Check the operator panel.

» Ifthe Toner low TK-17 message appears and the
ATTENTION indicator flashes, install a new toner kit.
See section 3.1.1 Toner Container Replacement
Interval on page 3-2.

* Set the print density to a darker level. See Adjusting
the Print Density on page 1-71.

Clean the charger wire.

Open the top and front covers of the printer. Remove the
process unit form the printer and slide the charger
cleaner knob back and forth a few times. See section 3.2
Cleaningon page 3-6.

Set the paper type to Thin.
From the operation panel, select Thin as the paper type.
See Selecting the Paper Source on page 1-66.

Grey background.

Check the operator panel.

If the Toner low TK-17 message appears and the
ATTENTION indicator flashes, install a new toner kit. See
section 8.1 Toner Container Replacement on page 3-2.

Check the print density.
Select a lighter print density setting. See Adjusting the
Print Densityon page 1-71.

Clean the charger wire.

Open the top and front covers of the printer. Remove the
process unit form the printer and slide the charger
cleaner knob back and forth a few times. See section 3.2
Cleaningon page 3-6.

Check the process unit.

Open the top and front covers of the printer and check
that the process unit is correctly installed and seated as
far as it can go.

Dirt on the top edge or back of the paper

Check the transfer roller.

Open the top and front covers of the printer. Remove the
process unit from the printer and make sure that the
transfer roller is clean. If it is not, print several pages
until the problem disappears.

Check the registration roller.

Open the top and front covers of the printer. Remove the
process unit from the printer and make sure that the
registration roller is clean. If it is not, wipe it with the
provided wiper cloth.

(Continued on next page)
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Printed Results Corrective Measures

Text is positioned incorrectly. Check the file or program.

Check whether the problem is being caused by a
PRESCRIBE command error. If the problem occurs only
with a specific file or program, the most likely cause is an
error in a parameter to a command or command syntax.

ABC

139
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4.3 Indicators and Messages

The following tables contain information about how to respond to problems
indicated by the operator panel indicators and messages.

4.3.1 Indicators

Indicator Name Condition Description
Flashing Indicates errors that you can correct yourself.
Lit Indicates that the printer is online and ready.
“ESD" BEADY Ooff Indicates that the printer is offline. The printer can receive data, but
indicator will not print it. This can also signal that printing has been
manually or automatically stopped due to an error. Check the
ATTENTION indicator.
Flashing Indicates a data transfer in process.
DATA DATA Lit Indicates either that data is being processed, or that data is being
o indicator written to the memory card.
Off Indicates that the printer is idle.
Flashing Indicates that paper has run out, that memory is insufficient, that
toner is low or other warning messages.
ATTENTION ATTENTION | Lit Indicates common errors (such as controller errors), when
o indicator mechanical maintenance is needed or indicates a problem that
requires a call to the service center.
Off Indicates the printer is operating normally.
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4.3.2 Maintenance Messages

The following table contains maintenance messages that you can deal with
by yourself. If Call serviceor Call service person appears, turn
the printer off, disconnect the power cord and contact your Kyocera Mita
dealer.

Message

Corrective Action

Add paper paper source

The ATTENTION indicator flashes. Indicates that paper has run out. Supply paper
according to the paper source that is Cass . (without option paper feeder), Cass. 1 or
Cass. 2 (with option paper feeder) and MP tray.

The paper cassette is not properly closed. Make sure the paper cassette is closed
securely.

Call service
person FO

The ATTENTION indicator turns on and the READY indicator goes off. Indicates a
problem with the controller and the front panel. Call a service person. The printer
does not operate when this message is displayed.

Call service

#H##

The ATTENTION indicator turns on. Indicates a controller error. Call a service
person. The printer does not operate when this message is displayed.

Call service
###4:0123456

The ATTENTION indicator turns on. Indicates a mechanical error. Call a service
person. 0123456 indicates the number of printed pages. (If #### is 7980 or 7990, see
below.)

Call service
7980:0123456

The ATTENTION indicator turns on. The waste toner reservoir is full. 0123456
indicates the number of printed pages. Turn off the printer’s power and remove the
process unit from the printer. Gently shake the process unit horizontally a few times,
then reinstall it into the printer. Turn on the printer’s power. If this error message
does not disappear, contact your Kyocera Mita dealer (less than 100,000 pages
printing).

Call service
7990:0123456

The ATTENTION indicator turns on. The waste toner reservoir is full. 0123456
indicates the number of printed pages. Same as above (100,000 pages printing or
more).

Close
top cover

The ATTENTION indicator turns on and the READY indicator goes off. Indicates that
either the top or front cover of the printer is open. Open and close again securely.

Load Cassette #
(paper size)/(paper type)*

*(paper size) and (paper
type) are displayed flashing
alternately.

The ATTENTION indicator turns on and and the READY indicator flashes. There is
data for printing that matches with a paper cassette setting (paper size, paper type),
but there is no paper in the paper cassette.

Set paper into the paper source as displayed on the operator panel, and the printer
will resume printing. However, the paper source number ( # ) is only displayed when
there is an option paper feeder installed.

Or, if you want to print from a different paper source press the ~ or v key to display
Use alternative? and you can change the source for paper feeding.

After selecting a paper source and pressing the MENU key, Paper Handling >
appears. By pressing the > key, the paper type settings menu appears. After setting
the correct paper type, press the ENTER key and printing starts.
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Message

Corrective Action

Load MP tray
(paper size)/(paper type)*

*(paper size) and (paper
type) are displayed flashing
alternately.

The ATTENTION indicator turns on and and the READY indicator flashes. There is
no paper cassette set (paper size, paper type) that matches with the data for printing,
so printing is done from the MP tray. Set paper into the MP tray that matches the
paper size and type shown on the display and press the GO key to restart printing.

Or, if you want to print from a different paper source press the A or Vv key to display
Use alternative? andyou can change the source for paper feeding.

After selecting a paper source and pressing the MENU key, Paper Handling >
appears. By pressing the > key, the paper type settings menu appears. After setting
the correct paper type, press the ENTER key and printing starts.

Note : Feeding the paper having a paper size which does not match the current paper
size from the MP tray can cause paper jam.

Paper jam
FHEHH S ESAS

The ATTENTION indicator turns on and the READY indicator goes off. Indicates that
paper is jammed in the printer. The location of the paper jam is also indicated in place
of the #’s. Open the top and/or front cover and pull out the jammed or misfed paper.

Paper path error

The ATTENTION indicator turns on. There is no paper cassette in the feeder, or the
cassette is not inserted properly. After reinserting the paper cassette, you should be
able to print.

Replace toner

The ATTENTION indicator turns on and the READY indicator goes off. Indicates that

TK-17 the printer has stopped because toner has run out. Replace the toner container with
a new one. Clean the printer after replacement.

Set paper The ATTENTION indicator turns on and the READY indicator flashes. Indicates

Press GO there is no paper in the MP tray. Add paper to the tray. Press the GO key to resume

printing.
Note : Feeding the paper having a paper size which does not match the current paper
size from the MP tray can cause paper jam.

Toner low
TK-17

The ATTENTION indicator flashes. Indicates that toner is running out. Replace the
toner container with a new one. Clean the printer after replacement.

Warning
image adapt

The ATTENTION indicator flashes. Indicates that the print job cannot be done at
current resolution because there is not enough internal memory. Try adding memory
or changing resolution.

Warning
low memory

The ATTENTION indicator flashes. Indicates that the printer’s memory is running
low because of the number of downloaded fonts and macros. Print a status page to see
how much user memory is left and try deleting unnecessary fonts and macros.

Warning waste
toner box

The ATTENTION indicator flashes. The waste toner reservoir in the process unit is
almost full. The waste toner reservoir will become full and the printer will stop
printing. Contact your Kyocera Mita dealer.
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4.3.3 Errors Messages

The following table lists error messages that can be dealt with by the user.

Message

Corrective Action

File not found
Press GO

The ATTENTION indicator is on and and the READY indicator flashes. Indicates that
the specified file is not found. If Auto Continue is set to On, printing will be
automatically resumed after a preset period of time. See Auto Continue Settingon
page 1-84.

Press the GO Key to resume printing. You can abondon printing by the CANCEL key.

Format error
Memory card

The ATTENTION indicator flashes. This message appears when the printer is in the
ready state and the memory card is not formatted, and therefore cannot be read or
written. Follow the procedure in Formatting a Memory Cardon page 1-563to format
the card.

I/F occupied

This message appears when you attempt to use the printer’s operator panel to change
the environmental settings on the interface from which data are presently being
received. The ATTENTION indicator flashes during 1.2 seconds, then it goes out and
the message display returns to the previous screen.

KPDL error ##
Press GO

The ATTENTION indicator is on and the READY indicator flashes. Indicates that a
KPDL-related error has occurred. The current print processing cannot continue.

To print out an error report, display > Print KPDL errs from the mode select menu,
and select On.

Press the GO key to resume printing. You can abandon printing by the CANCEL key.

Memory card err20

The ATTENTION indicator turns on. The printer has halted because you attempted to
insert/remove a memory card into/from the printer slot while the printer power is on.
Turn the power switch off and then on to restart the printer.

Note: Make sure to turn the printer power off before inserting/removing a memory
card.

Memory overflow
Press GO

The ATTENTION indicator is on and the READY indicator flashes. Indicates that the
total amount of data received by the printer exceeds the printer’s internal memory.
Press the GO key to resume printing. You can abandon printing by the CANCEL key.

MemoryCard err##
Press GO

The ATTENTION indicator is on and the READY indicator flashes. Indicates that an

error has occurred during access to the memory card using the PRESCRIBE RWER
command or from the printer’s operator panel. Look at the error code given in place of
## and refer to the corresponding description given below.

04: The capacity of the memory card is insufficient. Clean up files.

05: Specified file is not on memory card.

06: No memory for use by memory card. Expand printer memory.

Press the GO key to resume printing. You can abandon printing by the CANCEL key.

Print overrun
Press GO

The ATTENTION indicator is on and the READY indicator flashes. Indicates that the
data transferred to the printer was too complex to print on a page. Press the GO key
to resume printing. (The page may break in some pages.) You can abandon printing
by the CANCEL key.

Note: After this message is displayed, page protect mode is On. To maintain optimum
use of memory during printing, display >Page Protect fromthe operator panel, and
reselect Auto. See Page Protect Mode on page 1-40.
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Message Corrective Action
RAM disk error ## The ATTENTION indicator is on and the READY indicator flashes. Indicates a
Press GO problem with the RAM disk. Indicates that the data transferred to the printer was too

complex to print on a page. Look at the error code given in place of ## and refer to the
corresponding description given below.

01: Abnormal format. Try restarting the printer.

02: RAM disk mode is Of f. Turn RAM disk mode On.

04: No disk space. Clean up files.

05: Specified file is not on disk.

06: No memory for use by disk system. Expand printer memory.

Press the GO key to resume printing. You can abandon printing by the CANCEL key.
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4.4 Correcting a Paper Jam

This section describes how to remove paper when it jams in the printer.
The printer will stop whenever paper jams in the printer or paper is not fed
from a paper cassette. The printer will go offline and Paper jam message
will be displayed. When a jam occurs, check the points indicated in the
following and clear the jam as indicated.

If paper jams occur frequently, try using a different type of paper, replace
with paper from another ream, turn the stack of paper over, or turn the
paper the other way around. Read the information in Chapter 6. Also, look
for tiny pieces of paper that may have been torn apart and overlooked
when the jammed paper was removed.

If you cannot solve the problem by changing the paper, there may be a
problem with the printer. Call a service person.

* When pulling the paper, pull it gently so as not to tear it. Torn pieces
of paper are difficult to remove and may be easily overlooked,
Note deterring the jam recovery.

* Depending on where the jam occurred, the printer may or may not
reprint the jammed page.

4.4.1 Jam at the Face-down and Face-up Trays

When paper is fed part way out into the tray, pull the paper out the rest of
the way by hand. Open and close the printer’s top cover to clear the error.
The printer then automatically warms up and resumes printing.

Face-up Tray




Correcting a Paper Jam

4.4.2 Jam at the Paper Cassette

Pull out the paper cassette and remove any partially fed paper, then re-
close the paper cassette. Open and close the printer’s top cover to clear the
error. The printer then automatically warms up and resumes printing.
Follow the same steps for clearing the jammed paper at the option paper
feeder’s paper cassette.

Paper Feeder
(Option)

Paper Cassette Paper Feeder’s Paper Cassette

4.4.3 Jam Inside the Printer

When a paper jam occurs inside the printer, clear it using the following
procedure.

1 Open the printer’s top and front covers.

Top Cover




Correcting a Paper Jam

2 Remove the process unit from the printer as shown in the figure.

Process Unit

When the jammed paper appears to be pinched by rollers, pull it along
the normal paper running direction.

Note
4 After you have removed the jammed paper, put the process unit back

into the printer.

5 Close the printer’s front cover and top cover. The printer then
automatically warms up and resumes printing.
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Chapter 5  Paper Selection

This chapter explains the following topics:

General Guidelines
Selecting the Right Paper
Special Paper

Paper Type
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General Guidelines

5.1 General Guidelines

4

Note

The printer is designed to print on high-quality copier bond paper (the kind
used in ordinary dry copier machines), but it can also accept a variety of
other types of paper within the limits specified below.

The manufacturer assumes no liability for problems that occur when
paper not satisfying these requirements is used.

Selection of the right paper is important. Using the wrong paper can result
in paper jams, misfeeding, curling, poor print quality, and paper waste, and
in extreme cases can damage the printer. The guidelines given below will
increase the productivity of your office by ensuring efficient, trouble-free
printing and reducing wear and tear on the printer.

5.1.1 Paper Availability

Most types of paper are compatible with a variety of machines. Paper
intended for xerographic copiers can also be used with the printer.

There are three general grades of paper: economy, standard, and premium.
The most significant difference between grades is the ease with which they
pass through the printer. This is affected by the smoothness, size, and
moisture content of the paper, and the way in which the paper is cut. The
higher the grade of paper you use, the less risk there will be of paper jams
and other problems, and the higher the level of quality your printed output
will reflect.

Differences between paper from different suppliers can also affect the
printer’s performance. A high-quality printer cannot produce high-quality
results when the wrong paper is used. Low-priced paper is not economical
in the long run if it causes printing problems.

Paper in each grade is available in a range of basis weights (defined later).
The traditional standard weights are 16, 20, and 28 pounds (60 to 105 g/m?).

5.1.2 Paper Specifications

The following table summarizes the basic paper specifications. Details are
given on the following pages.

Table 5.1 Specifications

Item Specification

Weight Cassette :60 to 105 g/m? (16 to 28 Ib/ream)
MP tray :60 to 163 g/m? (16 to 43 Ib/ream)

Thickness 0.086 t0 0.110 mm (3.4 to 4.3 mils)

Dimensional accuracy +0.7 mm (+0.0276 inches)

Squareness of corners 90° +0.2°

Moisture content 4% to 6%

Direction of grain Long grain

Pulp content 80% or more
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5.2 Selecting the Right Paper

Laser printing is a process involving laser light, electrostatic discharge,
toner, and heat. In addition, as the paper passes through the printer it
undergoes considerable sliding, bending, and twisting motions. A high-
quality printing paper matching the printer’s requirements withstands all
these stresses, enabling the printer to turn out clean, crisp printed copies
consistently.

Remember that all paper is not the same. Some of the factors to consider
when selecting paper for the printer are as follows:

Condition of the Paper

Avoid using paper that is bent at the edges, curled, dirty, torn, embossed, or
contaminated with lint, clay, or paper shreds.

Use of paper in these conditions can lead to illegible printing, misfeeding,
and paper jams, and can shorten the life of the printer. In particular, avoid
using paper with a surface coating or other surface treatment. The paper
should have as smooth and even a surface as possible.

Composition

Do not use paper that has been coated or surface-treated and contains
plastic or carbon. The heat of fusing can cause such paper to give off
harmful fumes.

Bond paper should contain at least 80% pulp. Not more than 20% of the
total paper content should consist of cotton or other fibers.

5-3



Paper Size

Selecting the Right Paper

Cassettes and an MP tray are available for the paper sizes listed in
Table 5.2. The dimensional tolerances are 0.7 mm (+0.0276 inches) for the
length and width. The angle at the corners must be 90° +0.2°.

Table 5.2 Paper Sizes for Paper Feeding

Multi-Purpose tray Size Cassette or multi- Size
purpose tray
Monarch 3-7/8 x 7-1/2 inches Legal (Not available 8-1/2 x 14 inches
with the MP tray)
Business 4-1/8 x 9-1/2 inches Letter 8-1/2 x 11 inches
ISO DL 11 x 22 cm ISO A4 210 x 297 mm
ISO C5 16.2 x 22.9 cm ISO A5 148 x 210 mm
ISO B5 17.6 x 25 cm JISB5 182 x 257 mm
Executive 7-1/4 x 10-1/2 inches Custom Cassette:
Commercial 9 3-7/8 x 8-7/8 inches 148 t0 216 mm x 210 to 297 mm,
- - and Legal

Commercial 6-3/4 3-5/8 x 6-1/2 inches (5-13/16 t0 8-1/2 inches x 8-1/4 to
ISO A6 105 x 148 mm 11-11/16 inches)
JIS B6 128 x 182 mm MP tray:
Oficio IT 8-1/2 x 13 inches 70 to 216 mm x 148 to 297 mm
Statement 5-1/2 X 8-1/2 inches (2'13/16 to 8'1/2 inCheS X 5'13/16
Hagaki 100 % 148 mm to 11-11/16 inches)
Ofuku-Hagaki 148 x 200 mm Other sizes of paper can be fed manually. The minimum size
Youkei 2 114 x 162 mm paper for manual feed is 70 x 148 mm (2-13/16 x 5-13/16

- inches), fed lengthwise. The maximum size is 216 x 297 mm
Youkei 4 105 x 235 mm (8-1/2 x 11-11/16 inches).

Smoothness

The paper should have a smooth, uncoated surface. Paper with a rough or
sandy surface can cause voids in the printed output. Paper that is too
smooth, however, can cause multiple feeding and fogging problems.

(Fogging is a gray background effect.)

Basis Weight

Basis weight is the weight of a standard quantity of paper. In the
traditional system the standard quantity is a ream consisting of 500 sheets
measuring 17 x 22 inches each. In the metric system the standard quantity
is 1 square meter.

Paper that is too light or too heavy can cause misfeeding, jams, and
premature wear of the printer. Uneven paper weight can cause multiple
feeds, print defects, poor toner fusing, blurring, and other print quality
problems. The proper weight is 60 to 105 g/m? for the paper cassette, and
60 to 163 g/m? for the MP tray.
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Thickness (Caliper)

Thick paper is referred to as high-caliper paper and thin paper as low-
caliper paper. The paper used with the printer should be neither extremely
thick nor extremely thin. If you are having problems with paper jams,
multiple feeds, and faint printing, the paper you are using may be too thin.
If you are having problems with paper jams and blurred printing the paper
may be too thick. The proper thickness is 0.086 to 0.110 mm (3.4 to 4.3
mils).

Moisture Content

Moisture content is defined as the percent ratio of moisture to the dry mass
of the paper. Moisture can affect the paper’s appearance, feedability, curl,
electrostatic properties, and toner fusing characteristics.

The moisture content of the paper varies with the relative humidity in the
room. When the relative humidity is high and the paper absorbs moisture,
the paper edges expand, becoming wavy in appearance. When the relative
humidity is low and the paper loses moisture, the edges shrink and
tighten, and print contrast may suffer.

Wavy or tight edges can cause misfeeding and alignment anomalies. The
moisture content of the paper should be 4 to 6%.

To ensure the proper moisture content it is important to store the paper in
a controlled environment. Some tips on moisture control are:

* Store paper in a cool, dry location.

* Keep the paper in its wrapping as long as possible. Rewrap paper that
is not in use.

* Store paper in its original carton. Place a pallet etc. under the carton to
separate it from the floor.

+ After removing paper from storage, let it stand in the same room as the
printer for 48 hours before use.

* Avoid leaving paper where it is exposed to heat, sunlight, or damp.

Paper Grain

When paper is manufactured, it is cut into sheets with the grain running
parallel to the length (long grain) or parallel to the width (short grain).
Short grain paper can cause feeding problems in the printer. All paper used
in the printer should be long grain.
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Other Paper Properties

Porosity: Refers to the density of the paper structure; that is, to how openly
or compactly the fibers are bonded.

Stiffness: Limp paper can buckle inside the printer, while paper that is too
stiff may bind. Either way the result is a paper jam.

Curl: Most paper has a natural tendency to curl in one direction. The paper
should be loaded so that the natural curl is downward, to counteract the
upward curl imparted by the printer. Printed sheets will then come out flat.
Most paper also has a top and bottom surface. Loading instructions are
usually given on the paper package.

If the paper is considerably curled in one direction, e.g. when the paper
was used to print on one side, try to roll the paper in the opposite
direction to counteract the curl. Printed sheets will then come out flat.

Electrostatic properties: During the printing process the paper is
electrostatically charged to attract the toner. The paper must be able to
release this charge so that printed sheets do not cling together in the
output tray.

Whiteness: The contrast of the printed page depends on the whiteness of
the paper. Whiter paper provides a sharper, brighter appearance.

Quality control: Uneven sheet size, corners that are not square, ragged
edges, welded (uncut) sheets, and crushed edges and corners can cause the
printer to malfunction in various ways. A quality paper supplier should
take considerable care to ensure that these problems do not occur.

Packaging: Paper should be packed in a sturdy carton to protect it from
damage during transport. Quality paper obtained from a reputable
supplier is usually properly packaged.
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5.3 Special Paper

The following types of special paper can be used:
* Transparency (overhead projection film)

* Adhesive-backed label paper

* Envelopes

* Colored paper

* Preprinted paper

* Recycled paper

Use paper that is sold specifically for use with copiers (heat-fusing type).
Transparency, label paper, and envelopes should not be placed in the paper
cassette; they must be fed from the MP tray and delivered in the face up
stack.

Since the composition and quality of special paper vary considerably,
special paper is more likely than white bond paper to give trouble during
printing. No liability will be assumed if moisture and so forth given off
during printing on special paper causes harm to the machine or operator.

Before purchasing any type of special paper, test a sample on the printer
and check that printing quality is satisfactory.

Note

Specifications for each type of special paper are given below.

5.3.1 Transparency (overhead projection film)

Transparency must be able to withstand the heat of fusing during the
printing process. It should satisfy the conditions in Table 5.3.

Table 5.3 Transparency Specifications

Item Specification
Tolerance of heat Must tolerate at least 190°C (374°F)
Thickness 0.100 t0 0.110 mm (3.9 to 4.3 mils)
Material Polyester
Dimensional accuracy +0.7 mm (+0.0276 in)
Squareness of corners 90° + 0.2°

To avoid trouble, transparency must be delivered face-up.

If transparency jams frequently, pull the top of the sheet very gently as it
leaves the printer.
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5.3.2 Adhesive-Backed Labels

The basic rule for printing on adhesive labels is that the adhesive must
never come into contact with any part of the printer. Adhesive paper
sticking to the drum or rollers will damage the printer.

Label paper must be manually fed.

Label paper has a structure comprising three layers, as shown in Table 5.1
on page 5-2. The top sheet is printed on. The adhesive layer consists of
pressure-sensitive adhesives. The carrier sheet (also called the linear or
backing sheet) holds the labels until use. Due to the complexity of its
composition, adhesive-backed label paper is particularly likely to give
trouble in printing.

Top sheet (white bond paper)

Adhesive
Carrier sheet

Figure 5.1 Adhesive-backed label

Adhesive label paper must be entirely covered by its top sheet, with no
spaces between the individual labels. Labels with spaces in between are
apt to peel off, causing serious paper jam problems.

Some label paper is manufactured with an extra margin of top sheet
around the edge. Do not remove the extra top sheet from the carrier sheet
until after printing is finished.

Acceptable Unacceptable

~&— Top sheet—p

Carrier sheet—»

Figure 5.2 Label arrangement
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Table 5.4 lists the specifications for adhesive label paper.

Table 5.4 Adhesive Label Specifications

Item Specification
Weight of top sheet 44 to 74 g/m? (12 to 20 lb/ream)
Composite weight 104 to 151 g/m? (28 to 40 Ib/ream)
Thickness of top sheet 0.086 to 0.107 mm (3.9 to 4.2 mils)
Composite thickness 0.115 to 0.145 mm (4.5 to 5.7 mils)
Moisture content 4 to 6% (composite)

Envelopes

The printer can print on envelopes using paper with a basis weight of 60 to
79 g/m? (16 to 21 lb/ream). Envelopes must be manually fed.

An envelope is a more complex object than a single sheet of paper. For this
reason, it may not be possible to obtain consistent printing quality over the
entire envelope surface.

Many envelopes have a diagonal grain orientation. (See Paper Grain on
page 5-5.) This orientation is more likely to wrinkle and crease on its way
through the printer. Before purchasing envelopes for use with the printer,
test a sample to verify the envelope’s suitability.

Do not use envelopes that have an encapsulated liquid adhesive.

Avoid long printing runs consisting of envelopes only. Extensive envelope
printing can cause premature printer wear.

To avoid jamming due to curled envelopes, do not leave more than
approximately 10 printed envelopes stacked in the paper trays during
multiple envelope printing.

Colored Paper

Colored paper should satisfy the same conditions as white bond paper,
listed in Table 5.1 on page 5-2. In addition, the pigments used in the paper
must be able to withstand the heat of fusing during the printing process
(up to 200°C or 392°F).

Preprinted Paper

Preprinted paper should have a bond paper base. The preprinted ink must
be able to withstand the heat of fusing during the printing process, and
must not be affected by silicone oil.

Do not use paper with any kind of surface treatment, such as the type of
paper commonly used for calendars.
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Recycled Paper
Select recycled paper that meets the same specifications as the white bond
paper (see Table 6.1 on page 5-2) except whiteness.

Before purchasing recycled paper, test a sample on the printer and check
that the printing quality is satisfactory.
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5.4 Paper Type

The printer is capable of printing under the optimum setting for the type of
paper being used.

Setting the paper type for the paper source from the printer’s operator
panel will cause the printer to automatically select the paper source and
print in the mode best suited to that type of paper.

A different paper type setting can be made for each paper source including
the MP tray. Not only can preset paper types be selected, but it is also
possible for you to define and select customized paper types. See
Customizing the Paper Type on page 1-68.

The following types of paper can be set.

Table 5.5 Paper Type

Paper Source| MP Tray Paper Cassette | Paper Weight
Paper Type
Plain 0] 0] Normal
Transparency (@) X Heavy (Thick)
Preprinted (@) O Normal
Labels (©) X Normal
Bond (©) (©) Normal
Recycled (@) O Normal
Vellum O X Light (Thin)
Rough (@) O Normal
Letterhead (©) (©) Normal
Color ©) O Normal
Prepunched O o Normal
Envelope (@) X Normal
Cardstock O X Heavy
Custom 1 (to 8)* (@) (@) Normal

O : Can be stored X : Cannot be stored

£

This is a paper type defined and registered by the user. Up to eight types of user settings may
be defined. For details, see Customizing the Paper Typeon page 1-68.




Appendix A EFonts

This chapter describes the types of fonts you can use with the printer.
This appendix explains the following topics:

¢ Internal Fonts
e List of Fonts
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Internal Fonts

A.1 Internal Fonts

A font is a set of characters of a particular design. The design is referred to
as a typeface. Several characteristics identify a font. These include the code
set (for details on code sets, please read the Programming Manualprovided
on the CD-ROM supplied with the printer), spacing, pitch, height, style,
stroke weight, and typeface family.

The printer comes with 80 preinstalled PCL/PS compatible fonts and a line
printer bitmap font. Fonts may also be downloaded to the printer’s memory.
These are referred to as downloadable or soft fonts. The printer accepts as
many downloadable fonts as its user available memory permits.

A-2



List of Fonts

A.2 List of Fonts

This section contains a full list of the printer’s internal fonts. You can print
the same font list from the printer by using the operator panel. See
Printing a List of Fonts on page 1-36.

A.2.1 Internal Scalable and Bitmap Fonts and KPDL Fonts

Font
number Fontsamples

0 This is a sample of Courier font.
1 This is a sample of CGTimes font.

2 This is a sample of CGTimes-Bd font.

3 This is a sample of CGTimes-It font.

4 This is a sample of CGTimes-Bdlt font.

5 This is a sample of CGOmega font.

6 This is a sample of CGOmega-Bd font.

7 This is a sample of CGOmega-It font.

8 This is a sample of CGOmega-BdlIt font.

9 his is a samplo of Coronot font.

10 This is a sample of Clarendon-Cd font.

1 This is a sample of Univers-Md font.

12 This is a sample of Univers-Bd font.

13 This is a sample of Univers-MdIt font.

14 This is a sample of Univers-BdIt font.

15 This is a sample of Univers-MdCd font.

16 This is a sample of Univers-BdCd font.

17 This is a sample of Univers-MdCdlt font.

18 This is a sample of Univers-BdCdlt font.

19 This is a sample of AntiqueOlive font.
20  This is a sample of AntiqueOlive-Bd font.
21 This is a sample of AntiqueOlive-It font.
22 This is a sample of GaramondAntiqua font.
23 This is a sample of Garamond-HIb font.

24 This is a sample of Garamond-Krsv font.

25 This is a sample of Garamond-HIbKrsv font.
26 This is a sample of Marigold font.

27 This is a sample of Albertus-Md font.

28  This is a sample of Albertus-ExBd font.
29 This is a sample of Arial font.

30 This is a sample of Arial-Bd font.
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Font

number Font samples

31
32
33
34
35
36
37
38
39
40
a1
42
43
a4
45
46
a7
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69

This is a sample of Arial-It font.

This is a sample of Arial-BdIt font.

This is a sample of TimesNewRoman font.

This is a sample of TimesNewRoman-Bd font.

This is a sample of TimesNewRoman-It font.

This is a sample of TimesNewRoman-Bdlt font.

This is a sample of Helvetica font.

This is a sample of Helvetica-Bd font.

This is a sample of Helvetica-Ob font.

This is a sample of Helvetica-BdOb font.

This is a sample of Helvetica-Nr font.

This is a sample of Helvetica-NrBd font.

This is a sample of Helvetica-NrOb font.

This is a sample of Helvetica-NrBdOb font.

This is a sample of Palatino font.

This is a sample of Palatino-Bd font.

This is a sample of Palatino-It font.

This is a sample of Palatino-Bdlt font.

This is a sample of ITCAvantGardeGothic-Bk font.
This is a sample of ITCAvantGardeGothic-Dm font.
This is a sample of ITCAvantGardeGothic-BkOb font.

This is a sample of ITCAvantGardeGothic-DmODb font.
This is a sample of ITCBookman-Lt font.

This is a sample of ITCBookman-Dm font.

This is a sample of ITCBookman-LtIt font.

This is a sample of ITCBookman-DmlIt font.

This is a sample of NewCenturySchoolbook-Rom font.

This is a sample of NewCenturySchoolbook-Bd font.

This is a sample of NewCenturySchoolbook-It font.

This is a sample of NewCenturySchoolbook-BdlIt font.

This is a sample of Times-Rom font.

This is a sample of Times-Bd font.

This is a sample of Times-It font.

This is a sample of Times-Bdlt font.

This is a sample of ITCZapfChancery-MdIt font.

Tnio 16 a caunie o ZyuPor povr. (Symbol)

Tnio 1o o caunie odp ZYUPoAllE povt. (SymbolPS)

22K He So «cOOON, Ox' $HEVHLHEYoe XM (Wingdings)
Kotk A RA & ASROT@%k Ik Yoxoikfe Tk kKGR VA 21 (ITCZapfDingbats)
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number

Font samples

List of Fonts

70
71
72
73
74
75
76
77
78
79
80

This is a
This 1is a
This is a

sample of Courier-Bd font.
sample of Courier-It font.
sample of Courier-BdIt font.

This is a sample of LetterGothic font.
This is a sample of LetterGothic-Bd font.
This 1s a sample of LetterGothic-It font.

This is a
This is a
This is a
This is a

This is a sample

sample of CourierPS font.
sample of CourierPS-Bd font.
sample of CourierPS-0Ob font.
sample of CourierPS-BdOb font.

of LinePrinterBM8.5-Roman font.
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Font
KPDL Fonts (1)

This is a sample of Albertus-ExtraBold font.

This is a sample of Albertus-Medium font.

This is a sample of AntiqueOlive font.

This is a sample of AntiqueOlive-Bold font.

This is a sample of AntiqueOlive-Italic font.

This is a sample of Arial font.

This is a sample of Arial-Bold font.

This is a sample of Arial-Boldltalic font.

This is a sample of Arial-Italic font.

This is a sample of AvantGarde-Book font.

This is a sample of AvantGarde-BookOblique font.
This is a sample of AvantGarde-Demi font.

This is a sample of AvantGarde-DemiOblique font.
This is a sample of Bookman-Demi font.

This is a sample of Bookman-Demiltalic font.
This is a sample of Bookman-Light font.

This is a sample of Bookman-Lightltalic_font.

This is a sample of CGOmega font.

This is a sample of CGOmega-Bold font.

This is a sample of CGOmega-BoldlItalic font.

This is a sample of CGOmega-Italic font.

This is a sample of CGTimes font.

This is a sample of CGTimes-Bold font.

This is a sample of CGTimes-Boldltalic font.

This is a sample of CGTimes-Italic font.

This is a sample of Clarendon-Condensed-Bold font.

j/zid isa mmpé o/C}omnef %)»zf.

This is a sample of Courier font.

This is a sample of Courier-Bold font.

This is a sample of Courier-BoldObligque font.
This is a sample of Courier-Oblique font.

This is a sample of CourierPCL font.

This is a sample of CourierPCL-Bd font.

This is a sample of CourierPCL-BoldItalic font.

This is a sample of CourierPCL-Italic font.
This 1s a sample of Garamond-Antiqua font.

This is a sample of Garamond-Halbfett font.

This is a sample of Garamond-Kursiv font.

This is a sample of Garamond-KursivHalbfett font.
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Font
KPDL Fonts (2)

List of Fonts

This is a sample of Helvetica font.

This is a sample of Helvetica-Bold font.

This is a sample of Helvetica-BoldOblique font.
This is a sample of Helvetica-Narrow font.

This is a sample of Helvetica-Narrow-Bold font.

This is a sample of Helvetica-Narrow-BoldOblique font.

This is a sample of Helvetica-Narrow-Oblique font.

This is a sample of Helvetica-Oblique font.

This is a sample of LetterGothic font.

This is a sample of LetterGothic-Bold font.
This is a sample of LetterGothic-Italic font.

This is a sample of Marigold font.

This is a sample of NewCenturySchlbk-Bold font.
This is a sample of NewCenturySchlbk-BoldItalic font.
This is a sample of NewCenturySchlbk-Italic font.
This is a sample of NewCenturySchlbk-Roman font.
This is a sample of Palatino-Bold font.

This is a sample of Palatino-BoldItalic font.

This is a sample of Palatino-Italic font.

This is a sample of Palatino-Roman font.

Tnio 16 o counie oo Zyupoi dovt. (Symbol)

o 16 o copnie oo ZyuBoAIlIXA dovt. (Symbol MT)
This is a sample of Times-Bold font.

This is a sample of Times-BoldlItalic font.

This is a sample of Times-Italic font.

This is a sample of Times-Roman font.

This is a sample of TimesNewRoman font.

This is a sample of TimesNewRoman-Bold font.

This is a sample of TimesNewRoman-Boldltalic font.

This is a sample of TimesNewRoman-Italic font.
This is a sample of Univers-Bold font.

This is a sample of Univers-Boldltalic font.
This is a sample of Univers-Condensed-Bold font.

This is a sample of Univers-Condensed-Boldltalic font.
This is a sample of Univers-Condensed-Medium font.

This is a sample of Univers-Condensed-Mediumltalic font.
This is a sample of Univers-Medium font.

This is a sample of Univers-Mediumltalic font.

aXe He o OO OX $HEVo2 XMoo Yo (Wingdings-Regular)

This is a sample of Zaprﬁancery—Mez{iumI talic font.

KA kA & ASOO@K L1k K& ik VA BV (ZapfDingbats)
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Appendix B Options

This appendix explains available options, how to expand the printer’s
memory, and also how to install the memory card and the network interface
card.

* Available Options
* Expansion Memory Installation

* Memory (CompactFlash) Card
* Network Interface Card
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Available Options

B.1 Available Options

4]

Note

The following options are available for the printer:

Either the network interface card or the serial interface board can be
installed in the printer.

PF-17 Paper Feeder

Network Interface Card
Contact your Kyocera Mita dealer for information on purchasing the
network interface card that is best suited for use with this printer.

Only network interface cards operating on DC 3.3 V can be used in this
printer.

Memory (CompactFlash) Card

Contact your Kyocera Mita dealer for information on purchasing the
memory card that is best suited for use with this printer.
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Expansion Memory Installation

B.2 Expansion Memory Installation

This appendix begins by explaining how to install a DIMM (dual in-line
memory module) on the main circuit board.

The FS-1050 comes supplied with 16 MB of memory installed. A slot is
provided for expanding the memory in your printer so that more complex
printing can be done, as well as increasing the printing speed. By installing
optional DIMM into your printer, the memory in the FS-1050 can be
increased to a maximum of 144 MB.

* The expansion memory should be installed only by a Kyocera Mita
0 authorized dealer or Kyocera Mita certified technician. Kyocera Mita
“Note shall not be liable for damage due to improper installation of the
expansion memory.

* The following instructions are intended for the technician only.

Notes on Handling the Main Circuit Board and DIMM
Protect the electronics by taking these precautions:

* Before touching a DIMM, touch a water pipe or other large metal object
to discharge yourself of static electricity. While doing the work, it is
recommended that you wear an antistatic wrist strap.

* Touch the main circuit board and DIMM only by the edges.
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Expansion Memory Installation

DIMM to be used

Contact your Kyocera Mita dealer for information on purchasing the
DIMM that are best suited for use with this printer.

Either an 8 MB, 16 MB, 32 MB, 64 MB, or 128 MB DIMM can be used for
memory expansion.

Installing the DIMM
Insert the DIMM into the socket as follows:

1 Turn the printer’s power off, then unplug the printer’s power cable
and disconnect the printer from the host computer.

2 Remove the screw from the rear of the printer.

Side Cover
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Expansion Memory Installation

After removing the side cover, you can see the DIMM socket on top of
the main circuit board.

DIMM socket

4 Remove the DIMM from its package.

5 Open the clips on both ends of the DIMM socket.

Clips

6 Insert the DIMM into the DIMM socket so that the notches on the
DIMM align with the corresponding protrusions in the slot.

DIMM
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Expansion Memory Installation

7 Close the clips on the DIMM slot to secure the DIMM.

8 When you have finished installing the DIMM, replace the side cover
and fasten it with the screw.

To remove a DIMM:

Remove the side cover as shown in steps 1 to 3 on page B-4, then carefully
pull the end clips outwards and pull the DIMM out of the socket.

Testing the Expansion Memory

After you have finished installing DIMM in the printer, test the printer to
see if installation succeeded.

To test the expansion memory, proceed as follows:

1 Make sure the power switch is off. Plug the power cord into the
printer and turn on the power.

2 When the printer is online, print a status page using the operator
panel. (See Printing a Status Page on page 1-14.)

3 If the installation succeeded, the amount of memory shown on the
status page will correspond with the amount of expansion memory.
(The factory installed memory size is 16 MB.)
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Expansion Memory Installation

Setting the Printer Driver

After you install the additional memory to the printer, follow the
instructions below to set the printer driver so that the printer can use the
memories efficiently.

1 Click the Windows Start button, point to Settings then click Printers.
2 Right click the Kyocera Mita FS-1050 KX icon, and click Properties.
The Properties dialog box will open. Click the Device Settings tab.

3 Enter the total memory size installed to the printer (up to 144 MB)
in the Memory box.

Kyocera Mita F5-1050 KX Properties EE3
General I Dretailz I Color kM anagement I Sharing | Media | Layout I Imaging I
Prologue/E pilogue I Output Device Settings | About

Device Dptions:
[# Faper Feeder [Cassette 1]

[Paper Feeder [Cassette 2)
[CJRAM Disk

User.. | Memary: 43 ME :
Adminigtrator... | sk Dyek: I?MB i’

QK I Cancel Lol Help
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Memory (CompactFlash) Card

B.3 Memory (CompactFlash) Card

Note

Insert the memory (CF) card into the card slot located on the rear of the
printer. A memory card is a microchip card that may contain option fonts,
macros, forms, etc. The printer reads the contents of the card into its
internal memory when printer is turned on. The presence of this data in
the printer memory can be confirmed on the status page printout.

For details of available memory cards, contact your Kyocera Mita dealer.

1 Turn off the printer.

Never insert or remove a memory card while the printer power is on.
Failure to turn the power switch off will immediately halt the printer with
a Memory card err20 message (this message may not always appear).
It also could result in any damage to the printer’s electronic parts or the
memory card. Turn the power switch on again to restart the printer.

Remove the two screws from the option interface slot cover and
remove the slot cover.

Option Interface Slot Cover

Screws
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Memory (CompactFlash) Card

If the Network Interface Card or the Serial Interface Board is
installed

Remove the two screws from the network interface card or the serial
interface board and remove it.

Network Interface Card or
Serial Interface Board

3 Insert the memory card in the slot. Insert as shown in the figure.
Push it in all the way.

4 Close and secure the slot cover. If the network interface card or the
serial interface board kit is removed in the step 2 above, reinstall
and secure the card or the kit.
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Network Interface Card

Network Interface Card

If the serial interface board kit is installed, remove it to use the network
interface card.

Note

Insert the option network interface card into the option interface slot at the
rear of the printer. The network interface card enables the printer to be
used in a network.

1 Turn off the printer and disconnect the power cord and printer cable.

2 Remove the two screws from the option interface slot cover and
remove the slot cover.

Option Interface Slot Cover

Screws

3 Insert the network interface card and secure it with the screws
removed in step 2.

Network Interface Card
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AppendixC Host Computer
Interface

This appendix describes the signals used in the laser printer’s parallel and
RS-232C/RS-422A interfaces. It also lists pin assignments, signal functions,
timings, connector specifications, and voltage levels. The RS-232C/RS-422A
protocols are also covered. Finally, it explains how to use the printer in a
multi-computer environment.

This appendix explains the following topics:

* Parallel Interface

* TUSB Interface

* Serial Interface (Option)

* RS-232C/RS-422A Protocol
* RS-232C Cable Connection
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C.1

C.1.1

cl1 I2

Parallel Interface

Parallel Interface

Parallel Interface Communication Modes

|

Note

The printer features fast data transmission on the parallel interface. The
parallel interface mode can be activated from the operator panel.

Use a parallel printer cable that complies with the IEEE1284 standard.

Auto [default]

The printer automatically changes its communication mode to the one the
host computer is currently using. Ordinarily, you should leave this setting
unchanged.

Nibble (high)
High speed data communication is used in compliance with the IEEE 1284
standard.

Normal
The printer uses the standard communication method prescribed for
Centronics interfaces.

High-speed

This mode enables faster data transmission between the printer and the
host computer.

(Select this mode if printing problems occur when the printer is connected
to a workstation.)

Interface Signals

The pins of the parallel interface connector carry the signals listed in
Table C.1. Asterisks in the table indicate signals that are active low. The
table also indicates whether each signal is incoming or outgoing with
respect to the printer.

Table C.1 Parallel Connector Pin Assignment

Pin In/out Description
1 In Strobe* [nStrobe]
2 In Data 0 [Data 1]
3 In Data 1 [Data 2]
4 In Data 2 [Data 3]

(Continued on next page)
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Parallel Interface

Pin In/out Description

5 In Data 3 [Data 4]

6 In Data 4 [Data 5]

7 In Data 5 [Data 6]

8 In Data 6 [Data 7]

9 In Data 7 [Data 8]

10 Out Acknowledge* [nAck]
11 Out Busy [Busy]

12 Out Paper Empty [PError]
13 Out Online (Select) [Select]
14 In Ignored [nAutoFd]

15 - Not connected

16 - 0vDC

17 - Chassis GND

18 - +5V DC

19 - Ground return
20 - Ground return

21 - Ground return

22 - Ground return

23 - Ground return

24 - Ground return

25 - Ground return

26 - Ground return

27 - Ground return

28 - Ground return

29 - Ground return

30 - Ground return

31 In Reset [nlnit]

32 Out Error*, returns error status if FRPO 02=2 [nFault]
33 - -

34 - Not connected

35 Out Power Ready

36 In Select In [nSelectIn]

[1: Signal names in the Auto mode and Nibble (high) mode TEEE 1284). In the Auto mode and
Nibble (high) mode, these signals are bi-directional.

Detailed descriptions of the signals follow.

Strobe* [nStrobe] (Pin 1)

A negative-going Strobe* pulse causes the printer to read and latch the
data on the Data 0 [1] to Data 7 [8] signal lines.




Note

Parallel Interface

Data 0 [1] to Data 7 [8] (Pins 2 to 9)
These eight signals form the data byte sent from the host computer to the
printer. Data 7 [8] is the most significant bit.

Acknowledge* [nAck] (Pin 10)
This negative-going pulse acknowledges the previous character received by
the printer.

Busy [Busy] (Pin 11)
This signal is high when the printer is busy and low when it is able to
accept more data.

Paper Empty [PError] (Pin 12)
This signal goes high when the printer runs out of paper.

Online [Select] (Pin 13)

This signal is high when the printer is online and low when the printer is
offline. It goes low when the upper unit is raised, or when the GO key is
pressed to set the printer offline.

The Paper Empty and Online signals are not used unless enabled by the
FRPO command (02 parameter).

+5V DC (pin 18)
This line is connected to the printer’s +5V DC line (+5 V 0.5 V, maximum
400 mA, fused.)

Reset [nInit] (Pin 31)
This signal is used in the standard Centronics interface to enable the
computer to reset the printer.

Error* [nFault] (Pin 32)
When the high-speed parallel line control is on (FRPO 02=2), this line
returns error status.

Auxiliary output 1 (Pin 33)
This signal line is not used.

Power Ready (Pin 35)
This signal is high when the printer’s power is on.

Select In [nSelectIn] (Pin 36)
This signal is used in some versions of the Centronics interface to enable
the computer to force the printer online.
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USB Interface

C.2 USB Interface

This printer supports the USB (Universal Serial Bus) Revision 1.1
standards. USB interface specifications and interface signals are as
follows.

C.2.1 Specifications

Basic specification
Complies with the USB Revision 1.1 standards.

Connectors

Printer: B-type receptacle (female) with upstream port
Cable: B-type plug (male)

Cable

Use shielded cable that complies with the USB Revision 1.1 standards and
not longer than 5 meters (16 feet).

Transfer Mode
Full speed (max. 12 Mbps)

Power Control

Self-power device

C.2.2 Interface Signals

Table C.2 USB Connection Pin Assignment

Pin Signal Description
1 Vbus Power supply (+5V)
2 D- Data transmission
3 D+ Data transmission
4 GND Signal ground
Shell Shield
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Serial Interface (Option)

C.3 Serial Interface (Option)

Installing the optional serial interface board kit (IB-10E) in the printer
enables connection to a computer with an RS-232C or RS-422A standard
serial interface.

C.3.1 RS-232C Interface

Interface Signals

The pins of the printer’s RS-232C interface connector carry the signals
listed in Table C.3. The table also indicates whether each signal is
incoming or outgoing with respect to the printer.

Table C.3 RS-232C Signal Pin Assignments

Pin In/out Signal Description
1 - FG Frame ground
2 Out TXD Transmit Data
3 In RXD Receive Data
4 Out RTS Request To Send
5 In CTS Clear To Send
6 In DSR Data Set Ready
7 - SG Signal Ground
20 Out DTR Data Terminal Ready

Brief descriptions of the signals follow.

FG - Frame Ground - (Pin 1)
This pin is connected directly to the printer frame.

TXD - Transmit Data - (Pin 2)
This output carries asynchronous data sent by the printer to the computer.
It is used mainly in handshaking protocols.

RXD - Receive Data - (Pin 3)
This input carries serial asynchronous data sent by the computer to the
printer.

RTS - Request To Send - (Pin 4)
This output is always held high (above 3 volts).

CTS - Clear To Send - (Pin 5)
DSR - Data Set Ready - (Pin 6)
Unused.
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Serial Interface (Option)

SG - Signal Ground - (Pin 7)
All signals can transmit between the printer and the host computer to send
each signal with a signal ground.

DTR - Data Terminal Ready - (Pin 20)
This output is used as a buffer nearly-full handshake line. It is held high
(above 3 volts) when the buffer can accept more data.

RS-232C Interface Voltage Levels

The voltage levels of the interface signals conform to EIA RS-232C
specifications. SPACE is from 3 volts to 15 volts. MARK is from -3 volts to
-15 volts. Voltages between -3 volts and 3 volts are undefined.

C.3.2 RS-422A Interface

Note

The serial interface is set to the RS-232C mode as the factory default.
However, by changing the jumper connector on the IB-10E interface board,
the interface can be changed to the RS-422A mode.

In the RS-232C mode, the printer can be connected to a personal computer
(or similar device) equipped with an RS-232C serial interface. (The serial
interface is set to the RS-232C mode as the factory default.)

In the RS-422A mode, the printer can be connected to a personal computer

(or similar device) equipped with an RS-422A serial interface.

Changing of the jumper connector should be carried out only by a
Kyocera Mita authorized dealer or Kyocera Mita certified technician.
Kyocera Mita shall not be liable for damage due to improper changing of
the jumper connector.

Interface Signals

The pins in the printer’s RS-422A interface connector carry the signals
listed in Table C.4.

Table C.4 RS-422A Signal Pin Assignments

Pin In/out Signal Description
- FG Frame ground
3 In RDA Receive data Inverted
- SG Signal ground
9 Out SDA Send data Inverted
10 Out SDB Send data
11 - - +5VDC
18 In RDB Receive data
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Serial Interface (Option)

Overview of Signals (RS-422A)

FG - Frame Ground - (Pin 1)

This pin is connected directly to the printer frame.

SG - Signal Ground - (Pin 7)
All signals can transmit between the printer and the host computer to send
each signal with a signal ground.

RDB - Receive Data - (Pin 18)

RDA - Receive Data Inverted - (Pin 3)

These pins carry asynchronous data sent from the computer to the printer.
(differential input)

SDB - Send Data - (Pin 10)

SDA - Send Data Inverted - (Pin 9)

These pins carry asynchronous data sent from the printer to the computer.
(differential output)

RS-422A Interface Voltage Levels

The interface signal voltage levels conform with the EIA RS-422A
standard. The differential voltage varies from 200 mV to 6 V.

SERIAL Connector

The connector marked “IOIOI” (RS-232C/RS-422A) on the rear panel is a
DB-25S connector. Use a DB-25P connector (or equivalent) for the
connector on the cable.
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RS-232C/RS-422A Protocol

C.4 RS-232C/RS-422A Protocol

A protocol is a set of rules the computer follows in sending data to the
printer. The RS-232C/RS-422A parameters are stored in battery backed-up
memory. They are indicated on the status printout. They can be changed by
the FRPO (firmware reprogram) command described in the Programming
Manual provided on the CD-ROM supplied with the printer. The
parameters and their identification codes are given below.

H1: Baud rate

Parameter value Baud rate
12 1200
24 2400
48 4800
96 9600
19 19200
38 38400
57 57600
11 115200

The factory setting is 9600 baud.

H2: Data bits
7 or 8, factory-set to 8.

H3: Stop bits
1 or 2, factory-set to 1.

H4: Parity
Parameter value Meaning
0 None
1 Odd
2 Even
3 Ignore

The factory setting is “None” (0 on the status printout).
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Note

RS-232C/RS-422A Protocol

H5: Protocol logic

Parameter value Meaning
0 Combination of 1 and 3 below
1 DTR/DSR, positive logic
2 DTR/DSR, negative logic
3 XON/XOFF
4 ETX/ACK
5 XON/XOFF recognized only as protocol

The factory setting is 0.

H6: Buffer nearly-full threshold
This is a percentage from 0 to 99. The factory setting is 90.

H7: Buffer nearly-empty threshold
This is a percentage from 0 to 99. The factory setting is 70.

The factory settings of the buffer nearly-full and nearly-empty thresholds
(H6 and H7) are subject to change without notification.

The gap between the nearly-full and nearly-empty thresholds allows the
computer to send a fairly large amount of data in a continuous stream.

HS8: Received-data buffer size
This is the size of the input buffer, specified in units of 10 Kbytes. The
factory-set value is 6, meaning 60 Kbytes.

Since DTR/DSR protocol is not used with the RS-422A standard, select a
parameter value other than 0, 1, or 2 for the H5 setting when using the
RS-422A interface.

C.4.1 PRESCRIBE FRPO DO Command

The PRESCRIBE FRPO D0 command provides control over XON/XOFF
operation when an error occurs on the serial interface. The following table
summarizes the error status corresponding to different D0 values.

Serial interface error
Error not handled Error handled
Timing of XON transfer to XON sent every 3-5 seconds | D0=0 (default) Do=1
hOSt Whlle Ready or Waltlng XON not sent D0=10 D0=11




RS-232C Cable Connection

C.5 RS-232C Cable Connection

C.5.1 Obtain a Suitable RS-232C Cable

Make sure that the RS-232C cable is wired correctly. The cable must be a
null modem cable; that is, one in which pin 2 on either end of the cable is
connected to pin 3 on the other end. You cannot use a straight cable such as
IBM communication adapter cable type 1502067 unless you purchase a
null modem adapter.

C.5.2 Connecting the Printer to the Computer

Check that the power of both the printer and the computer is switched off.

1
2

O O~ W

Discharge yourself of static electricity by touching a metal object
such as a doorknob.

Remove the plastic cap from the printer’s RS-232C interface
connector.

Plug the printer end of the RS-232C interface cable into the printer’s
RS-232C connector and screw it in place.

Plug the other end of the cable into the computer’s RS-232C interface
connector.

Switch on the printer’s power.

The printer’s RS-232C parameters are factory-set to the following
values:

Baud rate=9600 bps, data bits (character length)=8 bits, stop bits=1,
parity=none

The two RS-232C protocols are XON/XOFF and DTR. The printer
performs both of them simultaneously, using positive logic for DTR.

If you are uncertain as to the printer’s current parameter settings,
you can reset them to the values listed above. See Selecting the
Serial Interface Mode on page 1-19.

Set the computer to the same parameters as the printer. On many
computers this can be done by setting DIP switches before the power
is turned on. Another method is as follows:
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RS-232C Cable Connection

With Windows 95/98/Me, make settings as follows:

1 Click on Start button in the Windows 95/98/Me Task Bar and align
the cursor with Settings, then click on Control Panel from among the
items displayed.

2 The control panel folder opens. Double click on System.

3 System Properties opens. Click on the Device Manager tab, then
click on the COM port to be used.

System Properties [ 7]

General Device Manager |Haldwale Profles | Perfomance |

& Wiew devices by lope " Wiew devices by connectian

Computer -
<& COROM

; Disk. drives

Digplay adapters
Floppy disk controllers

Hard disk controllers
@ Kepboard

@ honiter

7y Mouge

B8 MNebwork adapters

B Parts (COM & LPT)
©Y Printer Part LPT1)
i ta

B Ccrimiunications Port (M 1]
ry Communications Port ([COMZ)
g 55| contrallers ~

Sound, video and game contrallers
Fuopeties | Felresh | Remove | P, |

4 Click on Properties button.

5 The Properties sheet is displayed for the selected COM port. Click on
the Port Settings tab and set the port properties.

Communications Port [COM1) Properties [ 7] <]

General Part Settings | Diiver | Resouces |

Bits per second: -
Daabis [5 =]
Barity: |None -
Stop bits: lﬁ
Elowecortiok [won /et 7|

Advanced... | Bestore Defaults |

Cancel

6 After setting the properties, click OK button.




RS-232C Cable Connection

In DOS, enter the following commands:

C:\>MODE COM1:96,N,8,1,P
C:\>MODE LPT1:=COM1

To test the interface, enter the following:

CTRL P
C:\>DIR
CTRL P

The software settings made using the above procedures are temporary. On
most computers, permanent settings must be made with DIP switches.
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Printer Specifications

Printer Specifications

Item Description
Printing method Electrophotography, laser scan
Printing speed 14 pages/minute (A4 size/Plain)
15 pages/minute (Letter size/Plain)
When printing multiple copies of the same page
Resolution Fast 1200 mode
600 dpi (vertical and horizontal) with KIR (Kyocera Image
Refinement)
300 dpi (vertical and horizontal) with KIR (Kyocera Image
Refinement)
First print Approx. 22 seconds or less (A4), depends on input data
Warm-up time Approx. 10 seconds or less (from sleep mode)
Approx. 15 seconds or less (from power on)
at 23°C, 220V
Controller PowerPC 405 200 MHz
Main memory 16 MB, expandable up to 144 MB
Self test Performed at power-up
Maximum duty cycle 10,000 pages/month
Drum Organic Photoconductor
Developer Mono-component dry developer
Main charger Positive scorotron charger
Transferring Negative charger roller
Separation Curvature separation
Drum cleaning Blade cleaner
Drum discharging Illumination by eraser LED array
Fuser Heat roller and pressure roller
Toner saving EcoPrint mode
Paper Plain paper (See Chapter 5)
Waste toner capacity More than 100,000 pages (with 5% print coverage)
Paper feed trays Cassette: Legal size and A5 to A4/letter universal cassette 148 to
216 mm (5-13/16 to 8-1/2") x 210 to 297 mm (8-1/4 to 11-
11/16"). Holds 250 sheets of thickness 0.11 mm
MP tray: 70 to 216 mm (2-4/5 to 8-1/2") x 148 to 297 mm (5-13/16
to11-11/16") (see page 5-4). Holds 50 sheets of thickness
0.11 mm.
Capacity of output trays Face-down tray: 150 sheets of thickness 0.11 mm
Face-up tray: 30 sheets of thickness 0.11 mm
Ambient conditions Temperature: 10 to 32.5°C
Humidity: 20 to 80% RH
Optimum conditions: 23°C (73.4°F), 60% RH
Altitude: Max. 2000 m (6500 feet)
Illumination: Max. 1500 lux

(Continued on next page)
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Printer Specifications

Item

Description

Power requirements

220 to 240V, 50 Hz/60 Hz, max. 3.8 A
Max. allowable voltage fluctuation: +10%
Max. allowable frequency fluctuation: +2%

Power consumption Max.: 818 W
During sleep mode: 5 W

Operating noise (in accordance with ISO 7779 | During printing: LpA=50dB (A)

[Bystander Position, sound pressure level at During standby: LpA=28dB (A)

the front]) During sleep mode: Immeasurably low

Dimensions 378 (14-7/8) wide x 244 (9-5/8) high x 375 mm (14-3/4") deep
(Excl. the paper tray)

Weight 9.5 kg (20-15/16 lbs)
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Glossary

Cassette mode

This is an operation mode for the MP tray. When
this mode is used, approximately 50 sheets of
plain paper can be fed continuously, the same as
for the cassette.

dpi (dots per inch)

This indicates the number of dots printed per
inch, and is the unit of printer resolution.

EcoPrint

This is a printing mode that controls toner
consumption. Pages printed in the EcoPrint
mode are lighter than pages printed in the
normal mode. The default setting is Off.

Emulation

This refers to emulation of manufacturers’
printers. The printer emulates operation of the
following printers: PCL, Line printer, IBM
Proprinter, DIABLO 630, EPSON LQ-850,
KPDL.

Expansion memory

This option is used to increase printer memory.
The printer has one expansion slot, and you can
install a 16 MB, 32 MB, 64 MB, or 128 MB
DIMM (Dual Inline Memory Module). Contact
your Kyocera Mita dealer to purchase the DIMM
that is best suited for use with this printer.

Face-up tray

This is located at the rear of the printer. Select
paper output to the face-up tray when printing
on postcards, envelopes, or labels.

First mode

This is an operation mode for the MP tray. When
the MP tray setting is set to first mode (priority

printing from the MP tray) with paper inserted in
the MP tray, the first paper will always feed from

there even if another paper source is selected. The
printer is set to the cassette mode (another MP
tray operation mode) as the factory default, but
you can change this setting from the operator
panel.

IEEE1284

This is a standard used when connecting a
printer to a computer, and was established by the
Institute of Electrical and Electronic Engineers
in 1994.

KIR (Kyocera Image Refinement)

This is Kyocera Mita’s original smoothing
function. It uses software to enhance the
printer’s resolution and produce high-quality
printing. The default setting is On.

KM-NET VIEWER

This is a network management tool that can be
used with the printer. You can view information
for printers connected to the network using
SNMP commands. KM-NET VIEWER is contained
on the Kyocera Mita Digital Library CD-ROM
supplied with the printer.

KPDL

(Kyocera Printer Description
Language)

This is Kyocera Mita’s version of Adobe
PostScript 2.

Kyocera Mita Digital Library

This is the CD-ROM supplied with the printer.
The contents of the CD-ROM include manuals,
printer drivers, and various utilities.

MB (mega byte)

This unit is used to express data quantities and
memory capacities. 1 MB is equivalent to
1024 kB, or 1,048,576 bytes.
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MP tray

This is an abbreviation for Multi-Purpose tray.
The MP tray is used instead of the cassette when
printing on envelopes, postcards, transparency
sheets, and labels.

Offline

The printer can receive data, but cannot print.
Turn the printer online if you want to print.

Online

The printer can output received data.

Operator panel

This is located on the top right side of the printer.
The panel consists of the message display, three
indicators and eight keys. The message display
shows the printer’s status. Press the keys when
you want to switch the printer between online
and offline status, to cancel printing, to use the
menu system, and so on.

Outline font

With outline fonts, characters outlines are
represented by numerical expressions, and fonts
can be enlarged, reduced, or painted in different
ways by changing the numeric values of those
expressions. Printing remains clear even if you
enlarge fonts, since the letters are defined by an
outline. You can specify font size in steps of 0.25
points up to 999.75 points.

Parallel interface

With this interface, data transfer between the
printer and the computer takes place on 8-bit
chunks. The printer can perform IEEE1284
compatible bi-directional communications.

Glossary

PRESCRIBE commands

This is the Kyocera Mita page printer control
language installed on Kyocera Mita printers.
PRESCRIBE commands enable most print
settings necessary for pagination, and are easy to
understand because they are written in text
format, allowing you to do programming yourself.
For information on the commands and how to use
them, refer to the Programming Manual
contained on the CD-ROM supplied with the
printer.

Printer driver

The printer driver makes it possible for you to
print data created using application software.
The printer driver for the printer is contained on
the Kyocera Mita Digital Library CD-ROM
supplied with the printer. Install the printer
driver on the computer connected to the printer.

Process unit

This is the printer’s main module and contains
the photosensitive drum and developer unit.

RAM disk

This is a virtual disk drive that uses part of the
printer’s memory. With RAM disk you can set
any memory size arbitrarily, and use electronic
sorting (to reduce print time).

Simple Network Management
Protocol (SNMP)

This is a protocol for the management of
networks that use TCP/IP (Transmission Control
Protocol/Internet Protocol).

Sleep mode

This mode is activated after a specified amount
of time elapses. The printer goes into economy
mode and a minimum amount of power is
consumed. You can change the amount of time
before the printer goes into sleep mode from the
operator panel. The default setting is 5 minutes.




Glossary

Status page

This lists printer conditions, such as the printer’s
memory, the total number of copies printed, and
paper source settings. You can print the status
page from the operator panel.

USB (Universal Serial Bus)

An interface standard for tow to middle speed
serial interfaces. This printer supports USB
revision 1.1. The maximum transfer rate is 12
Mbps and the maximum cable length is 5 meters
(16 feet).
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